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Abbreviations 

 

Abbreviation Definition 

BSC Basic Science Course 

PCC Programme Core Course 

PEC Programme Elective Course 

MDM Multidisciplinary Minor 

OE Open Electives 

HSSM Humanities, Social Science, and Management Course 

VEC Value Education Courses 

VSEC Vocational and Skill Enhancement Courses 

CEP Community Engagement Project 

FP Field Project 

OJT On Job Training 

HON Honor Course 

DM Double Minor 

RM Research Methodology 

HR Honor with Research 

L Lecture 

P Practical 

T Tutorial 

CA Continuous Assessment 

MSE Mid Semester Exam 

ESE End Semester Exam 

CR Credits 

Back to Index 
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B.Tech. in Information Technology with 

Multidisciplinary Minor 

 

Vision 

 
To be a center of excellence in Information Technology education, research, and 

innovation, nurturing globally competent professionals with ethical values and social 

responsibility. 

Mission 
 

M1: To impart strong theoretical and practical knowledge in emerging areas of Information 

Technology. 

M2: To promote interdisciplinary learning, innovation, and research culture. 

M3: To inculcate ethical values, leadership skills, and societal responsibility. 

M4: To develop industry-ready professionals with lifelong learning capabilities. 

 

Programme Educational Objectives (PEOs) 
 

PEO1: Apply engineering principles, computing knowledge, and modern tools to solve real- 

world problems in industry, academia, and entrepreneurship. 

PEO2: Engage in innovation, research, or higher studies to advance in their professional 

careers. 

PEO3: Demonstrate ethical behavior, leadership, teamwork, and communication skills in 

multidisciplinary environments. 

PEO4: Contribute to society by developing sustainable, inclusive, and technology-driven 

solutions. 

PEO5: Pursue continuous learning and adapt to technological advancements throughout 

their professional journey. 
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Programme Outcomes (POs) 
 

PO1: Engineering Knowledge: Apply knowledge of mathematics, science, engineering 

fundamentals and Information Technology specialization to solve complex problems. 

PO2: Problem Analysis: Identify, formulate, research literature, and analyze complex 

engineering problems to reach substantiated conclusions. 

PO3: Design/Development of Solutions: Design IT solutions and systems to meet desired 

needs with consideration for public health, safety, culture, society, and environment. 

PO4: Conduct Investigations of Complex Problems: Use research-based knowledge and 

methods to analyze and interpret data and provide valid conclusions. 

PO5: Modern Tool Usage: Create, select and apply appropriate techniques, resources, and 

modern IT tools for complex engineering activities. 

PO6: The Engineer and Society: Apply contextual knowledge to assess societal, legal, 

and cultural issues relevant to professional practice. 

PO7: Environment and Sustainability: Understand the impact of IT solutions in societal 

and environmental contexts and demonstrate sustainable development. 

PO8: Ethics: Apply ethical principles and commit to professional ethics and 

responsibilities. 

PO9: Individual and Team Work: Function effectively as an individual and as a member 

or leader in diverse teams and multidisciplinary settings. 

PO10: Communication: Communicate effectively with engineering communities and 

society at large, and write effective reports and documentation. 

PO11: Project Management and Finance: Demonstrate knowledge of project management 

and financial principles to manage projects in a multidisciplinary environment. 

PO12: Lifelong Learning: Recognize the need for lifelong learning in the context of 

technological change. 

 

Programme Specific Outcomes (PSOs) 
 

PSO1: Apply the principles and practices of computing and software engineering to develop 

real-world IT solutions in domains like Web, Data Analytics, Networks, and 

Cybersecurity. 

PSO2: Demonstrate proficiency in using modern tools, programming languages, and 

platforms for effective problem-solving and project implementation. 

PSO3: Exhibit leadership, innovation, and ethical responsibility in IT practices, with 

effective teamwork and communication. 
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PEO–PO–PSO Correlation Matrix 
 

PEOs \ 

POs / PSOs 
PO 

1 

PO 

2 

PO 

3 

PO 

4 

PO 

5 

PO 

6 

PO 

7 

PO 

8 

PO 

9 

PO 

10 

PO 

11 

PO 

12 

PS 

O1 

PS 

O2 

PSO 

3 

PEO1 3 3 3 2 3 2 2 2 2 2 2 2 3 3 2 

PEO2 2 3 2 3 3 1 1 2 2 2 2 3 2 3 2 

PEO3 1 2 2 1 2 3 2 3 3 3 2 2 1 2 3 

PEO4 2 2 3 2 2 3 3 3 2 2 2 2 3 2 3 

PEO5 2 2 2 2 2 2 2 2 2 2 2 3 2 2 2 

Note: Values in the matrix represent the level of correlation between PEOs and POs/ PSOs:1– 

Low, 2– Medium, 3–High. 
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Curriculum Structure for 

Second Year B. Tech (Information Technology) 
 

Semester – III 

 

Sr. 

No. 

 

Course 

Type 

 

Course code 

 

Course Name 

Hours Examination Scheme Credits 

L P C
A

 

M
S

E
 

E
 S

 E
 

T
o

ta
l 

M
a

rk
s 

T
o

ta
l 

1 BSC 25AF1000BS301 Engineering Mathematics III 3 -  20  20 60 100 3 

2 PCC 25AF1246PC302 Data Structures 3 -  20 20 60 100 3 

3 PCC Lab 25AF1246PCL303 Data Structures Lab - 2 60 - 40* 100 1 

4 PCC 25AF1246PC304 
Object Oriented Programming 

using Java  
3 - 20 20 60 100 3 

5 PCC Lab 25AF1246PCL305 
Object Oriented Programming 

using Java Lab 
- 2 60 - 40* 100 1 

6 MDM 25AF1246MD306 Multidisciplinary Minor-1 2 -  20 20 60 100 2 

7 OE 25AF1246OE307 
Open Elective – 1 (any course from 

University OE Basket) 
3 -  20 20 60 100 3 

8 AEC 

25AF1246AEL308A Modern Indian Languages   (any 

one) 

A) Marathi (मराठी) 
B) Hindi (ह िंदी) 
C) Sanskrit (सिंस्कृत) 

- 2 60 - 40† 100 1 25AF1246AEL308B 

25AF1246AEL308C 

9 HSSM 25AF1246HM309 ITPM 2 -  20 20  60 100 2 

10 VEC1 25AF1000VE310A 
Life of Chhatrapati Shivaji 

Maharaj 
1 - 60 - 40† 100 1 

11 CEP / FP 25AF 1246CP311 
Community Engagement Project 

/field Project 
- 4 60 - 40* 100 2 

Total 17 10 420 120 560 1100 22 

 

*Practical/Oral evaluation of 40 marks at the end of the semester. 

†Presentation/Oral evaluation of 40 marks at the end of the semester. 
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Semester – IV 

 

 

Sr. 

No. 

 

 

Course 
Type 

 

 

Course code 

 

Course Name 

Hours  Examination Scheme    Credits 

 

L 

 

P C
A

 

M
S

E
 

E
 S

 E
 

T
o

ta
l 

M
a

rk
s 

T
o

ta
l 

1 PCC 25AF1246PC401 Analysis of Algorithms 3 - 20 20 60 100 3 

2 
PCC Lab 25AF1246PCL402 

Analysis of Algorithms 

Lab - 2 60 -  40* 100 1 

3 
PCC 25AF1246PC403 

Computer Organization 

and Architecture 3 - 20 20 60 100 3 

4 PCC 25AF1246PC404 Discrete Mathematics 3 - 20 20 60 100 3 

5 MDM 25AF1246MD405 Multidisciplinary Minor-2 3 - 20 20 60 100 3 

6 OE 
25AF1246OE406 

Open Elective – 2 (any course 

from University OE Basket) 2 - 20 20 60 100 2 

7 VSEC 25AF1246VSL407 Web Technology 1 2 60 -  40* 100 2 

8 
HSSM 25AF1246HM408 

Innovation and 

Entrepreneurship 2 - 60 -  40† 100 2 

9 
VEC2 25AF1000VE409B 

Life of Bharat Ratna Dr 

Babasaheb Ambedkar 1 -  60 - 40† 100 1 

10 VEC3 25AF1000VE410C UHV-II 2 - 20 20 60 100 2 

Total 20 4 360 120 520 1000 22 

 
*Practical/Oral evaluation of 40 marks at the end of the semester. 

†Presentation/Oral evaluation of 40 marks at the end of the semester. 
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List of Multidisciplinary Minor (MDM) Courses offered by 

Department of Information Technology 

 

 

 

Multidisciplinary Minor (MDM) Courses 

 

 

Sr. 

No. 

 

 

 

Course 

Type 

 

 

 

Semester 

 

 

 

Course code 

 

 

 

Course Name 

 

Hours 

 

Examination Scheme 

 

Credits 

L P C
A

 

M
S

E
 

E
 S

E
 

T
o
ta

l 

M
a
rk s Total 

1 MDM Sem-III 25AF1246MD306 Data Structures 2 - 20 20 60 100 2 

2 MDM Sem-IV 25AF1246MD405 
Computer 

Organization and 

Architecture 

3 - 20 20 60 100 3 

3 MDM Sem-V 25AF1246MD508 Machine learning 3 - 20 20 60 100 3 

4 MDM Sem-VI 25AF1246MD609 Cloud Computing 3 - 20 20 60 100 3 

5 MDM Sem-VIII 25AF1246MD809 Artificial Intelligence 

 

3 - 20 20 60 100 3 

 

Total 

 

14 

 

0 

 

100 

 

100 

 

300 

 

500 

 

14 

 
Note: Information Technology department Students will choose a Multidisciplinary Minor 

(MDM) Bucket (a Set of Courses to be learnt from 2nd Year to Third/Final Year) offered by 

the other departments. 

 

 

 

 

 

 

 

Back to Index 
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List of Open Elective (OE) Courses offered by University 

 

Faculty-wise baskets of OE are prepared by University which are chosen from 

faculty other than that of the Major Faculty i.e. in this case Major Faculty is 

Faculty of Engineering. Other Faculties considered are as follows:  

1. Faculty of Management and Commerce  

2. Faculty of Law 

3. Faculty of Humanities and Arts  

4. Faculty of Architecture and Planning  

5. Faculty of Health Sciences  

6. Faculty of Science 

 Students need to take up three or four courses of 08 credits over semesters 

III to V 

Open Elective (OE) Courses 

 

 

 
  Sr. 
No. 

 

 

 

Course 

Type 

 

 

 

Semester 

 

University OE Courses link  
Hours Examination Scheme Credits 

 

 

L 

 

 

P 

  
 C

A
 

 M
S

E
 

  
 E

 S
E

 

T
o
ta

l 

M
a
rk

s 

 

 

Total 

1 
OE Sem-III 

 

https://dbatu.ac.in/wp-

content/uploads/2024/08/Open-Electives-

Buckets-for-University-Campus-2024-25.pdf 

3 - 20 20 60 100 3 

2 
OE Sem-IV 2 - 20 20 60 100 2 

3 
OE Sem-V 3 

- 20 20 60 100 3 

Total 8 0 60 60 180 300         8 

 
Note: It is essential for students to choose these courses from disciplines other than their 

major programme (i.e. engineering) for which they initially enrolled in during their first year 

( ex.B. Tech. IT). 

 

 

 

 

Back to Index 

https://dbatu.ac.in/wp-content/uploads/2024/08/Open-Electives-Buckets-for-University-Campus-2024-25.pdf
https://dbatu.ac.in/wp-content/uploads/2024/08/Open-Electives-Buckets-for-University-Campus-2024-25.pdf
https://dbatu.ac.in/wp-content/uploads/2024/08/Open-Electives-Buckets-for-University-Campus-2024-25.pdf
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List of Honor Courses offered by Department of Information 

Technology 

 

Honor (HON) Courses 

 

 

 

Sr. 

No. 

 

 

 

 

Course 

Type 

 

 

 

 

Semester 

 

 

 

 

Course code 

 

 

 

 

Course Name 

 

Hours 

 

Examination Scheme 

 

Credits 

 

 

L 

 

 

P C
A

 

M
S

E
 

E
 S

E
 

T
o

ta
l 

M
a
rk

s 

 

 

Total 

1 HON 
 

Sem-III 25AF1246HON301 
Optimization 

Techniques 3 - 20 20 60 100 3 

2 
 

HON 
 

Sem-IV 25AF1246HON402 

Advanced 

Algorithms and 

Data Structures 
3 - 

 

20 

 

20 

 

60 100 3 

3 
 

HON 
 

Sem-V 25AF1246HON503 

Advanced 

Computer 

Architecture 
3 

 

- 

 

20 

 

20 

 

60 100 3 

4 HON 
 

Sem-VI 25AF1246HON604 Mobile Computing 3 - 20 20 60 100 3 

5 HON 
 

Sem-VII 25AF1246HON705 
Robotics and 

Embedded Systems 3 
 

- 20 20 60 100 3 

6 HON Sem-VIII 25AF1246HON806 
Artificial Neural 

Networks 3 
 

- 20 20 60 100 3 

Total    18   0   120 120   360   600       18 

NEP-2020-GR-Technical-4th-July-2023[2(d),PP-3] 

Note: Students with a CGPA ≥ 7.5 after the first year are eligible to opt for 6 additional courses 

(18–20 credits) from their parent (major) department. 

 

 

 

 
Back to Index 
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List of Double Minor (DM) Courses offered by Department of 

Information Technology 

 

Double Minor (DM) Courses 

 

 

 
  Sr. 
No. 

 

 

 

Course 

Type 

 

 

 

Semester 

 

 

 

Course code 

 

 

 

    Course Name 

Hours Examination Scheme Credits 

 

 

L 

 

 

P 

 

C
A

 

 

M
S

E
 

 

E
 S

E
 

T
o

ta
l 

M
a
rk

s  

 

Total 

1 DM Sem-III 
25AF1246DM301 

Computer 

Networks 

Fundamentals 
3 - 20 

20 60 100 3 

2 DM Sem-IV 25AF1246DM402 
Data science and 

visualization 3 - 20 20 60 100 3 

3 DM Sem-V 
25AF1246DM503 

IT Service 

Management 

(ITSM) 
3 - 20 20 60 100 3 

4 DM Sem-VI 
25AF1246DM604 

DevOps 

(Development 

and operations) 
3 - 20 20 60 100 3 

5 DM Sem-VII 25AF1246DM705 UI/UX Design 3 - 20 20 60 100 3 

6 DM Sem-VIII 25AF1246DM806 Data Security 3 - 20 20 60 100 3 

Total 18 0 120 120 360 600 18 

NEP-2020-GR-Technical-4th-July-2023[3(e),PP-3] 

Note: Student are required to select a double minor program from a department other than 

their major programme (Students who enrolled in their first year of engineering is the major 

programme B. Tech. IT) and it must different from the Multidisciplinary Minor 

programme. 

 

 

 

Back to Index 

file:///D:/Dean%20Accademics%20work_KRS/Information%20Technology/Complete%20SY%20Syllabus_IT_NEP_2024%2025%20July%2001.docx%23_Data_Security
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List of Honor with Research Courses in Semester –VII and Semester 

-VIII offered by Department of Information Technology 

Honor with Research (HR) Courses 

 

Sr. 

No. 

 

Course 

Type 

Semester Course code Course Name 

 

   Hours 

 

Examination Scheme 

 

Credits 

 

L 

 

P C
A

 

M
S

E
 

E
S

E
 

T
o
ta

l 

M
a
rk

s 

 

Total 

1 
HR 

 

Sem-VII 

25AF1246HRL701 

Research Orientation, 

Literature Review & 

Proposal Approval 

(Includes: problem 

identification, research 

gap analysis, and 

proposal defense) 

- 6 
 

60 
 

- 
 

40 100 3 

2 
HR 

 

Sem-VII 

25AF1246HRL702 

Project Implementation 

– Phase I & IPR 

Awareness 

(Initial design, 

development, and 

Intellectual Property 

Rights & Research Ethics 

training) 

- 6 
 

60 
 

- 
 

40 100 3 

3 
HR 

 

Sem-VIII 

25AF1246HRL803 
Project Implementation – 

Phase II & Documentation 
(Final implementation, 

validation, and thesis 

preparation) 

- 6 
 

60 
 

- 
 

40 100 3 

4 
HR 

 

Sem-VIII 

25AF1246HRL804 

Research Paper Writing & 

Publication 

(Target: Scopus/Web of 

Science/IEEE/UGC-CARE 

journals or reputed 

conferences) 

- 6 
 

60 
 

- 
 

40 100 3 

5 
HR 

 

Sem-VIII 

25AF1246HRL805 

Final Viva / Project Defense 

(Internal & External 

evaluation, defense of research 

work) 

- 

 

12 

 

100 

 

 

 
 

100 

 

200 
 

6 

Total - 36 340 - 260 600 18 

Note: Students with a CGPA ≥ 7.5 or 75% after the 6th semester are eligible for the UG 

Research degree and must complete an additional 18-credit research project/dissertation in 

the 4th year within their major discipline. 
NEP-2020-GR-Technical-4th-July-2023[2(c),PP-3] 

 Back to Index 
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1. Mind Map: Selection Procedure for MDM Courses 

 

 

NEP-2020-GR-Technical-4th-July-2023[3(b),PP-5] 

2. Mind Map: Selection Procedure for OE Courses 

 

NEP-2020-GR-Technical-4th-July-2023[3(c),PP-5] 
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3. Mind Map: Selection Procedure for Honors with Research Programme 

 

 

NEP-2020-GR-Technical-4th-July-2023[2(c),PP-3] 

4. Mind Map: Selection Procedure for Honors Programme 

 

NEP-2020-GR-Technical-4th-July-2023[2(d),PP-3] 
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5. Mind Map: Selection Procedure for Double Minor Courses 

Programme 
 

 

 

Note: The example provided in the above mind map is for better understanding for students 

and faculty. It is not compulsory to choose the specific example courses mentioned. 

NEP-2020-GR-Technical-4th-July-2023[3(e),PP-3] 
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Credit Distribution: 

1. B.Tech. degree with a multidisciplinary minor: 
 

 

SEM- I SEM -II SEM-III SEM-IV SEM-V SEM-VI SEM-VII SEM –VIII TOTA L 

21 23 22 22 21 23 22 18       172 
(160-176) 

 

2. B.Tech. honour with multidisciplinary minor: 
 

SEM- I SEM -II SEM-III SEM-IV SEM-V SEM-VI SEM-VII SEM –VIII TOTA L 

21 23 22+3 22+3 21+3 23+3 22+3 18+3 
172+18 
=190 

        (180-194) 

 

3. B.Tech. honour with Research and multidisciplinary minor: 

 

SEM- I SEM -II SEM-III SEM-IV SEM-V SEM-VI SEM-VII SEM –VIII TOTA L 

21 23 22 22 21 23 22+6 18+12 
172+18 

=190 
        (180-194) 

 

4. B.Tech. degree with Double Minors (Multidisciplinary and Specialization 

Minors) : 
 

SEM- I SEM -II SEM-III SEM-IV SEM-V SEM-VI SEM-VII SEM –VIII TOTA L 

 

21 
 

23 
 

22+3 
 

22+3 
 

21+3 
 

23+3 
 

22+3 
 

18+3 
172+18 

=190 

        (180-194) 

Back to Index 
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List of Exit Options after Second Year, B.Tech to Qualify for  

Diploma in Information Technology 
 

Sr. 

No. Course Code Semester          Name of the course 

Credits 

Theory Practical Total 

1 25AF1246EX401 Sem-IV Mobile App Development 120Hr 8 

Total 120 8 

 

OR 

Sr. 

No. Course Code  Semester         Name of the course 

Credits 

Theory Practical Total 

1 25AF1246EX402 Sem-IV        Office Assistance 120Hr 8 

Total 120 8 

 

Important criteria for the Exit Option after Second Year 

Total Additional Credits 

Required 
08 

Certificate Awarded Diploma in IT 

Requirement 
Completion of any one Skill-Based Course  listed in the 

Exit Option Structure 

Duration Summer Vacation 

Important Guidelines 

1. Option Registration 
Must be registered with the Parent Department & Exam 

Section 

2. Prerequisite 
Clearing of all course work till the End of Second Year 

as a Regular Student. 

3. Minimum Credits Earned 80 

4. Evaluation 
Conducted by the Department for the award of the said 

certification. 

5. Document Submission 
Original Course/Internship Certificates required at the 

time of evaluation 

NEP-2020-GR-Technical-4th-July-2023[7(b),PP-11]

Back to Index 
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Criteria for Re-entry or Lateral Entry under NEP 2020 
 

Sr.No. Re-entry or Lateral Entry (NEP 2020) 

1. Re-entry Option: Students exiting at any level can rejoin the same or another 

institution within 4 years to complete their degree. 

2. Maximum Duration: The entire degree must be completed within 8 years from the 

date of first admission. 

3. Based on Credits: Re-entry or lateral entry is allowed based on valid earned credits 

stored in the Academic Bank of Credits (ABC). 

4. Multiple Entry Paths: Students can re-enter into UG Diploma, B.Voc, UG Degree 

(Single/Double Minor), Honours, or Research programs. 

5. Subject to Availability: Admission depends on intake capacity and validation of 

prior learning outcomes. 

NEP-2020-GR-Technical-4th-July-2023[7(c),PP-11] 

 

 

Back to Index 
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Syllabus of SEMESTER-III Courses 

Teaching 

Scheme 
Engineering Mathematics – III 

Course code: 25AF1000BS301 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

1. Engineering Mathematics – I and II 

Course Objectives: 

1. Linear differential equations of higher order using analytical 

methods and numerical methods applicable to Control systems and 

Network analysis. 

2. Transforms such as Fourier transform, Laplace transform and 

applications to Communication systems and Signal processing.  

3. Vector differentiation and integration required in Electro-magnetics 

and Wave theory.  

4. Complex functions, conformal mappings, contour integration 

applicable to Electrostatics, Digital filters, Signal and Image 

processing.  

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Solve higher order linear differential equation using appropriate 

techniques for modelling and analyzing electrical circuits. 

CO2: Solve problems related to Fourier transform, Laplace transform 

and applications to Communication systems and Signal 

processing. 

CO3:  Obtain Interpolating polynomials, numerically differentiate and 

integrate functions, numerical solutions of differential equations 

using single step and multi-step iterative methods used in modern 

scientific computing. 

CO4:  Perform vector differentiation and integration, analyze the vector 

fields and apply to Electromagnetic fields.  

CO5: Analyze conformal mappings, transformations and perform 

contour integration of complex functions in the study of 

electrostatics and signal processing. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 

PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 
 

3 
 

2 
 

2 
 

2 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

2 
 

2 
 

1 
 

1 
 

CO2 3 
 

2 
 

2 
 

2 
 

2 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

2 
 

2 
 

1 
 

1 
 

CO3 3 
 

3 
 

2 
 

3 
 

3 
 

1 
 

1 
 

1 
 

2 
 

1 
 

1 
 

2 
 

3 
 

2 
 

1 
 

CO4 3 
 

2 
 

2 
 

2 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

2 
 

1 
 

1 
 

CO5 3 
 

2 
 

2 
 

2 
 

2 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

1 
 

2 
 

1 
 

1 
 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low,   

2– Medium, 3–High. 
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COURSE CONTENTS 

Unit 

No. 
Unit Details Hours 

1 Laplace Transform : Definition – conditions for existence ; Transforms of 

elementary functions ; Properties of Laplace transforms - Linearity property, first 

shifting property, second shifting property, transforms of functions multiplied by 

tn , scale change property, transforms of functions divided by t, transforms of 

integral of functions, transforms of derivatives ; Evaluation of integrals by using 

Laplace transform ; Transforms of some special functions- periodic function, 

Heaviside-unit step function, Dirac delta function. 

8 Hrs 

2 Inverse Laplace Transform : Introductory remarks ; Inverse transforms of some 

elementary functions ; General methods of finding inverse transforms ; Partial 

fraction method and Convolution Theorem for finding inverse Laplace 

transforms ; Applications to find the solutions of linear differential equations and 

simultaneous linear differential equations with constant coefficients. 

8 Hrs 

3 Fourier Transform :Definitions – integral transforms ; Fourier integral theorem 

(without proof) ; Fourier sine and cosine integrals ; Complex form of Fourier 

integrals ; Fourier sine and cosine transforms ; Properties of Fourier transforms ; 

Parseval‟s identity for Fourier Transforms. 

8 Hrs 

4 Partial Differential Equations and Their Applications : Formation of Partial 

differential equations by eliminating arbitrary constants and functions; Equations 

solvable by direct integration; Linear equations of first order (Lagrange‟s linear 

equations); Method of separation of variables – applications to find solutions of 

one dimensional heat flow equation (), and one dimensional wave equation. 

8 Hrs 

5 Functions of Complex Variables : Analytic functions; Cauchy- Riemann 

equations in Cartesian and polar forms; Harmonic functionsin Cartesianform; 

Cauchy ‟sintegral theorem;Cauchy‟ sintegral formula; Residues; Cauchy‟s 

residue theorem (All theorems without proofs). 

8 Hrs 

 Textbooks: 
1. Grewal, B. S., Higher Engineering Mathematics. Khanna Publishers, New Delhi. 

2. Das, H. K., and Verma, Er. Rajnish, Higher Engineering Mathematics. S. Chand 

& Co. Pvt. Ltd., New Delhi. 

3. Singh, B. B., A Course in Engineering Mathematics (Vol. III). Synergy 

Knowledgeware, Mumbai. 

4. Ramana, B. V., Higher Engineering Mathematics. Tata McGraw-Hill 

Publications, New Delhi. 

Reference Books: 
1. Kreyszig, Erwin, Advanced Engineering Mathematics. John Wiley & Sons, New 

York. 

2. O’Neil, Peter, A Textbook of Engineering Mathematics. Thomson Asia Pte Ltd., 

Singapore. 

3. Wylie, C. R., and Barrett, L. C., Advanced Engineering Mathematics. Tata 

McGraw-Hill Publishing Company Ltd., New Delhi. 

4. Singh, B. B., Integral Transforms and Their Engineering Applications. Synergy 

Knowledgeware, Mumbai. 

5. Sneddon, I. N., Integral Transforms. Tata McGraw-Hill, New York. 

 

Back to Index 
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Teaching 

Scheme 

Data Structures 

Course code: 25AF1246PC302 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

1. Programming and Problem Solving  

2. Fundamentals of  C Programming Languages 

Course Objectives: 

1. To understand importance of data structures in context of writing 

efficient programs. 

2. To be able to implement linear and non-linear data. 

 

Course Outcomes (COs): 

Upon successful completion of this course, students will be able to:  

CO1: Understand and Analyze various types of data structures and 

algorithms  

CO2:  Apply various sorting algorithms for given problem. 

CO3: Make Use of Stacks and Queues to solve the given problem. 

CO4: Understand the Linked List data structure. 

CO5: Demonstrate basic operations on trees and graph. 

CA 20 

PR 1 MSE 20 

CR 4 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 1 2 1 1 1 - - - - - - - 2 3 3 

CO2 3 2 3 1 1 1 - - - - - - 3 2 3 

CO3 3 3 3 2 1 1 1 1 - 1 - - 2 3 2 

CO4 3 3 3 2 1 1 2 1 - 2 - - 3 3 3 

CO5 3 3 3 3 - 1 1 - - - - - 2 3 3 

 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Introduction to Data Structures: Abstract Data Types (ADT), Types of Data 

Structure: Linear and Non-linear. Concept of Recursion: Definition, Example 

(Tower of Hanoi). Static and Dynamic data structure. 

05 Hrs 

2 Stack: Definition, Representation techniques: Static and Dynamic, Operations 

(Algorithm):  PUSH, POP, DISPLAY. Application of Stack: Converting the 

expressions like Infix, Postfix, Evaluating the expression. 

Queue: Definition, Representation techniques: Static and Dynamic, Operations 

(Algorithm):  INSERT, DELETE, DISPLAY. Types of Queue: Circular, Double 

Ended, Priority. Application of Queue. 

07 Hrs 

3 Linked List: Definition, Representation techniques: Static and Dynamic, Types 

of Linked list: Singly, Doubly, Circular. Operations (Algorithm): Insertion and 

Deletion: At BEGINNING, SPECIFIC, END for Singly linked list and Doubly 

linked List. Application of Linked List. 

07 Hrs 

4 Tree: Definition, Basic concept, Terminology, Types of Tree: Binary tree, Binary 

Search tree, AVL tree. Operation (Algorithm): INSERT, DELETE, and SEARCH 

for binary tree. Binary Tree traversals. Application of tree.  

07 Hrs 

5 Graph: Definition, Types of graph, Representation techniques: Adjacency 

matrix, Adjacency list. Traversals: Depth first and Breadth first, Application of 

graph: Minimum Spanning Tree. 

Searching and Sorting: Various searching methods: Linear Search, Binary 

search. Various sorting methods: Insertion, Selection, Merge, Quick. 

09 Hrs 

 Text Books: 
1. Horowitz, E., Mehta, D., & Sahni, S. (2008). Fundamentals of Data 

Structures in C++ (2nd ed.). Silicon Press. 

2. Lipschutz, S. (2010). Data Structures with C (1st ed.). Tata McGraw-Hill. 

3. Bichkar, R. S. (2014). Programming with C and Data Structures (1st ed.). 

Universities Press. 

Reference Books: 
1. Goodrich, M. T., & Tamassia, R. (2014). Data Structures and Algorithms 

in Java (6th ed.). Wiley. 

2. Cormen, T. H., Leiserson, C. E., Rivest, R. L., & Stein, C. (2009). 

Introduction to Algorithms (3rd ed.). MIT Press. 

3. Goyal, V., Goyal, L., & Kumar, P. (2014). A Simplified Approach to Data 

Structures (1st ed.). Shroff Publishers. 
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Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No

. 

NPTEL/SWAYAM 

Courses Name 

Instructor Host Institute Links 

01 Data Structure 

using C 

Programming 

Dr. Dipti 

Verma and 

Mr. Aditya 

Tiwari 

Chhattisgarh Swami 

Vivekanand Technical 

University, Bhilai 

https://onlinecourses.swayam2.ac.i

n/nou25_cs06/preview 

02 Data Structures and 

Algorithms Design 

Prof. Nitin 

Saxena 

IIT Kanpur https://onlinecourses.nptel.ac.in/no

c25_cs81/preview 
 

 

 

  

Back to Index 
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Teaching 

Scheme 

Data Structures Lab 

Course code: 25AF1246PCL303 

Examination 

Scheme 

2 Hrs / Week 

= Credit 1 Course Outcomes (COs): 

Upon successful completion of this course, students will be able to: 

CO1: Implement recursive solutions like Tower of Hanoi and understand 

the concept of recursion. 

CO2: Apply operations on linear data structures such as Stack and Queue 

using C. 

CO3: Create and manipulate various types of linked lists through 

different operations. 

CO4: Implement non-linear data structures like Binary Trees and perform 

various tree traversals. 

CO5: Demonstrate searching and sorting techniques with real-time 

programming applications. 

 

CA 60 

ESE 40 

TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 
 

2 
 

2 
 

2 
 

3 
 

- - - - - - 1 
 

2 
 

3 
 

2 
 

CO2 3 
 

3 
 

2 
 

2 
 

3 
 

- - - - - - 1 
 

2 
 

3 
 

2 
 

CO3 - 3 
 

3 
 

3 
 

2 
 

3 
 

- - - 2 
 

1 
 

- 1 
 

2 
 

3 
 

CO4 3 
 

3 
 

3 
 

3 
 

3 
 

- - - - 1 
 

- 1 
 

3 
 

3 
 

2 
 

CO5 - 3 
 

3 
 

3 
 

2 
 

3 
 

- - - - - - 1 
 

3 
 

3 
 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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 List of Experiments: 

1. Write a program for implementing recursion by Tower of Hanoi. 

2. Write a menu driven program for implementation of stack by 

using following methods: PUSH, POP and DISPLAY. 

3. Write a menu driven program for implementation of queue by 

using following methods: INSERT, DELETE and DISPLAY. 

4. Write a menu driven program for implementation of singly linked 

list by using following methods: Insert a node at beginning, 

deleting a node from beginning and display singly linked list after 

any operation.  

5. Write a menu driven program for implementation of singly linked 

list by using following methods: Insert a node at specific, deleting 

a node from specific and display singly linked list a after any 

operation. 

6. Write a menu driven program for implementation of singly linked 

list by using following methods: Insert a node at end, deleting a 

node from end and display singly linked list a after any operation. 

7. Write a menu driven program for implementation of Binary tree 

by using following methods: Insert, Delete, Search, and Display. 

8. Write a menu driven program for implementation of Binary tree 

traversal by using following methods: Pre-Order, In-Order and 

Post-Order. 

9. Write a program for Searching an element: Linear, Binary  

10. Write a program for sorting an array: Merge, Quick. 

 

Note: 

1. The above list is for illustration purposes only. The course coordinator 

may update or change the list as needed, 

2. At least 8 to10 experiments should be performed. 

3. Students should be encouraged to design and perform new experiments, 

subject to prior approval from the respective subject authority. 
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Teaching 

Scheme 

Object Oriented Programming using Java 

Course code: 25AF1246PC304 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

       1.Programming for Problem Solving 

Course Objectives: 

1. To understand the Fundamentals of Java Programming. 

2. To develop Logical Thinking Using Control Structures and 

Methods. 

3. To implement and Manipulate Arrays and Object-Oriented 

Features. 

4. To handle Exceptions and Multithreading. 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: To describe the structure of Java programs, core concepts of 

memory, arithmetic operations, and the role of Java Class 

Libraries in application development. 

CO2: To develop Java programs using object-oriented principles 

including classes, objects, constructors, methods, and instance 

variables. 

CO3: To apply control structures and modular programming concepts 

such as static methods, method overloading, and logical operators 

to solve real-world problems. 

CO4: Implement arrays, inheritance, polymorphism, and interfaces to 

build scalable and reusable Java applications. Analyse the concept 

of small and micro enterprise. 

CO5: Demonstrate exception handling mechanisms in Java and 

multithreading. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 
PO6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 2 1 
- 

2 
- - - - - - 

2 2 
- - 

CO2 3 2 2 
- 

3 
- - - - - - 

3 3 
- - 

CO3 3 2 1 
- 

2 
- - - - - - 

2 2 
- - 

CO4 3 3 3 - 3 - - - - - - 3 3 - - 

CO5 3 3 3 - 3 - - - - - - 3 3 - - 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. 
Topic Hours 

1 Introduction to Java Applications: Introduction, Java Class Libraries, Typical 

Java Development Environment, Memory Concepts, Arithmetic. Introduction to 

Classes and Objects: Introduction, Classes, Objects, Methods and Instance 

Variables, Declaring a Class with a Method and Instantiating an Object of a 

Class, Declaring a Method, Instance variables, set Methods and get Methods, 

Primitive Types vs. Reference type double Types ,Initializing Objects with 

Constructors, floating point numbers. 

07 Hrs 

2 Control Statements: Control structures if single-selection statement, if….else 

double-selection statement, while repetition statement, do….while repetition 

statement, switch multi-selection statement, break and continue statements, 

logical operators. Methods :Introduction, Program modules in Java, static 

methods, static Fields and Class Math, declaring methods with multiple 

parameters, scope of declaration, method overloading and Java API packages. 

07 Hrs 

3 Arrays: Arrays, declaring and creating arrays in java, examples using arrays, 

passing arrays to methods, multidimensional arrays, variable-length argument 

lists, using command-line arguments. 

07 Hrs 

4 Inheritance and Polymorphism in Java: Inheritance: Super classes and 

Subclasses, protected members, relationship between super classes and 

subclasses, constructors in subclasses, object class. Polymorphism: Abstract 

classes and methods, final methods and classes, polymorphism examples and 

Interfaces. 

07 Hrs 

5 
Exception-handling and multithreading: Exception-handling overview, 

handling Arithmetic Exceptions and Input Mismatch Exceptions, when to use 

exception handling, java exception hierarchy, finally block. Multithreading: 

Creating threads, Extending thread class, Stopping and Blocking a thread, Life 

cycle of a thread, Using thread method, Thread exceptions, Implementing the Run 

able interface, Inter thread communication. 

07 Hrs 

 Text Book: 

1. Paul Deitel and Harvey Deitel, Java: How to Program, Pearson's 

Publication, 9th Edition. 

Reference Books: 

1. Joel Murach and Michael Urban, Murach’s Beginning Java with Eclipse, 

Murach's Publication, 1st Edition, 2016. 

2. Doug Lowe, Java All-in-One For Dummies, Wiley Publication, 4th 

Edition, 2014. 

3. Herbert Schildt, Java: The Complete Reference, McGraw-Hill Publication, 
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9th Edition. 

4. Patrick Niemeyer and Daniel Leuck, Learning Java, O'Reilly Media, 4th 

Edition, 2013. 

5. Douglas Crockford, JavaScript: The Good Parts, O’Reilly, ISBN: 

9782744055973. 

6. Microsoft® .NET: Architecting Applications for the Enterprise, 

Microsoft Press, 1st Edition, ISBN: 978-0735626096. 

 

Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No. NPTEL/SWAYAM 

Courses Name 

Instructor Host Institute Links 

01 Programming in 

Java  

Debasis 

Samanta 

IIT Kharagpur https://nptel.ac.in/courses/106105191 
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Teaching 

Scheme 

Object Oriented Programming using Java Lab 

Course code: 25AF1246PCL305 

Examination 

Scheme 

TH - Course Objectives: 

1. Develop foundational programming skills using Java language 

constructs, including operators, method calling 

2. Explore object-oriented programming concepts in Java 

3. Apply modular programming techniques using functions and 

packages 

4. Implement exception handling and error management in Java 

programs 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Apply Java programming concepts such as operators, methods, 

classes, constructors, arrays, inheritance, and exception handling to 

develop structured and object-oriented applications. 

CO2: Demonstrate modular programming and code reuse in Java through 

the use of packages, interfaces, access modifiers, and binding 

techniques. 

CO3: Apply and understand basics of exception handling and use of 

multithreading. 

CA 60 

PR 2 MSE - 

CR 1 ESE 40 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 2 1 1 - - 1 - - 2 2 - - 3 2 1 

CO2 2 
- 

1 2 
- - - - 

2 2 1 
- 

2 2 
- 

CO3 2 
- 

3 1 1 1 
- - 

2 
- - - - 

2 1 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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List of Experiments: 

1. Programs on Operators, Arithmetic Promotion, Method Calling. 

2. Programs on Classes: String and Math.  

3. Write a program to demonstrate following Function concepts 

i. Function overloading  

ii. Constructors of all types  

iii. Default parameters, returning by reference  

4. Programs on dealing with Arrays.  

5. Programs on Classes: String and Math.  

6. Programs on Inheritance and Polymorphism.  

7. Programs on Garbage collection, packaging, access Modifiers, as 

well as static and abstract modifiers.  

8. Programs on Interfaces, block initializers, final Modifier, as well 

as static and dynamic binding.  

9. Programs on Exception Handling.  

10. Write a Java program that illustrates the following  

i. Creation of simple package.  

ii. Accessing a package.  

iii. Implementing interfaces.  

11. Program to create thread by Thread class and Runnable interface. 

12. Program to show the use of Synchronized keywords using threads.   

Note: 

1. The above list is for illustration purposes only. The course coordinator 

may update or change the list as needed, 

2. At least 8 to10 experiments should be performed. 

3. Students should be encouraged to design and perform new experiments, 

subject to prior approval from the respective subject authority. 
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Teaching 

Scheme 

Modern Indian Languages 

Marathi (मराठी) 
Course code: 25AF1246AEL308A 

Examination 

Scheme 

TH - पाठ्यक्रम उद्दिष्टे (Course Objectives): 

1. आधनुिक मराठी भाषेच ेव्याकरण, सिंवादकौशल्य आणण साह त्ययक 
सिंकल्पिा आयमसात करणे. 

2. मराठी भाषेच्या ववकासामध्ये सामात्िक, सािंस्कृनतक व पात्चचमायय 
प्रभावािंचा अभ्यास करणे. 

3. शैक्षणणक व व्यावसानयक लेखि कौशल्य ववकससत करणे. 
4. मराठी व इिंग्रिी भाषािंतरासिंबिंधी कौशल्य प्राप्त करणे. 
5. भाषेच्या माध्यमातूि सामात्िक आणण सािंस्कृनतक िाणीव 

ववकससत करणे. 

अभ्यासक्रम परू्ण केल्यावर ववद्यार्थयाांना येर्ारी कौशल्ये 
(Course Outcomes - COs): 
CO1: मराठी भाषेची मूलभूत माह ती, सलपी आणण व्याकरण आयमसात 

करणे. 
CO2: मराठी सिंवादकौशल्य, लेखि व वाचि प्रावीण्य प्राप्त करणे. 
CO3: मराठी साह ययाचा अभ्यास करूि सािंस्कृनतक िाणणवा ववकससत 

करणे. 
CO4: भाषािंतर व व्यावसानयक सिंवादाच ेकौशल्य प्राप्त करणे. 

CA 60 

PR 2 ESE 40 

CR 1 TOTAL 100 

   

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 2 - - - 1 - - - - 2 - 2 - 1 - 

CO2 - - 1 - 2 - - - 2 3 - 2 - 2 2 

CO3 - - - - - 2 2 2 1 2 - 2 1 - 2 

CO4 1 - 2 - 2 2 - 2 2 3 - 2 2 2 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs: 1–Low, 2– 

Medium, 3–High. 
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प्रयोग अभ्यासक्रम 

आठवडा प्रयोगात्मक कायण  

१ मराठी सलपी आणण उच्चारािंचा सराव, भाषचेा इनत ास  

२ साधी, सिंयकु्त व समश्र वाक्यरचिा, सिंवाद व असभव्यक्ती  

३ इिंग्रिी त ेमराठी भाषािंतर (सोप्या वाक्यािंवर आधाररत)  

४ मराठी त ेइिंग्रिी भाषािंतर (लघपुररच्छेदािंवर आधाररत) 
 

५ औपचाररक पत्रलेखि (रिा अिज, ववििंती पत्र इ.) 
 

६ अिौपचाररक पत्रलेखि (व्यत्क्तगत पत्र)े 
 

७ पररच्छेद / सारािंश लेखि (१००–१५० शब्द) 
 

८ वयृतलेखि – कायजक्रम / बातमी यावर आधाररत 
 

९ सिंवाद लेखि – पररत्स्ितीिसुार सिंवाद 
 

१० वाचि सराव – उच्चार व शब्दसिंग्र  वदृ्धी  

११ सिंभाषण सराव – मलुाखत / भसूमकानिसमजती (role-play) 
 

१२ अिंनतम प्रयोगायमक परीक्षा व तोंडी परीक्षा (Internal Test + Viva) 
 

 

पाठ्यपुस्तके: 
1. मराठी भाषेच ेमूळ – लेखक: वव. िा. खरें 
2. मराठी भाषेचा इततहास – लेखक: गिं. िा. िोगळेकर 

3. मराठी भाषा: उगम व ववकास – लेखक: कृ. पा. कुलकणी 
4. साद्दहत्याची भाषा – लेखक: डॉ. भालचिंद्र िेमाड े

संदभण ग्रथं: 
1. सुगम मराठी व्याकरर् व लेखन – लेखक: मो. रा. वाळिंबे 
2. अनुवाद: तत्त्वज्ञान आणर् प्रयोग – लेखक: डॉ. भालचिंद्र िेमाडे 
3. प्रशासकीय लेखन – प्रकाशक: भाषा सिंचालिालय, म ाराष्ट्र शासि 

4. मराठी भाषा आणर् साद्दहत्याचा इततहास – लेखक: व. का. रािवाड े

5. बनगरवाडी – लेखक: व. प.ु माडगुळकर 

6. ढग – लेणखका: उषा शेळके 

7. बटाट्याची चाळ – लेखक: पु. ल. देशपािंड े

8. NPTEL/SWAYAM Digital Reference : 

https://onlinecourses.swayam2.ac.in/nou25_lg30/preview 

 

https://onlinecourses.swayam2.ac.in/nou25_lg30/preview
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Teaching 

Scheme 

Modern Indian Languages 

Hindi (द्दहदंी) 
Course code: 25AF1246AEL308B 

Examination 

Scheme 

TH - पाठ्यक्रम उिेश्य (Course Objectives): 

1. ह िंदी भाषा के उद्भव, ववकास और ऐनत ाससक प्रवतृ्यतयों का ज्ञाि 
करािा। 

2. ह िंदी व्याकरण, सलवप तिा लेखि कौशल में प्रवीणता प्रदाि 
करिा। 

3. प्रशासनिक, शैक्षणणक एविं सिंवादायमक दृत्ष्ट्िकोण से ह िंदी के 
व्याव ाररक प्रयोग को समझािा। 

4. अिुवाद कौशल ववकससत कर तकिीकी तिा व्यवसानयक सिंवाद 
को सरल बिािा। 

अपेक्षित पाठ्यपररर्ाम (Course Outcomes - COs): 

CO1: ह िंदी भाषा के ऐनत ाससक ववकास, सलवप और व्याकरण की मलूभतू 
िािकारी प्राप्त करिा। 

CO2: ह िंदी सिंवाद कौशल, लेखि और वाचि में दक्षता प्राप्त करिा। 
CO3: साह यय और सामात्िक सिंदभों से भाषा की सािंस्कृनतक समझ 

ववकससत करिा। 
CO4: ह िंदी और अिंगे्रिी अिवुाद कौशल अत्िजत कर व्यावसानयक सिंवाद 

स्िावपत करिा। 
 

CA 60 

PR 2 ESE 40 

CR 1 TOTAL 100 

   

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 2 - - - 1 - - - - 2 - 2 - 1 - 

CO2 - - 1 - 2 - - - 2 3 - 2 - 2 2 

CO3 - - - - - 2 2 2 1 2 - 2 1 - 2 

CO4 1 - 2 - 2 2 - 2 2 3 - 2 2 2 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs: 1–Low, 2– 

Medium, 3–High. 
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प्रायोगगक अभ्यासक्रम 
 

सप्ताह प्रयोगात्मक अभ्यास  

१ 
ह िंदी सलवप और उच्चारण का अभ्यास, भाषा का ऐनत ाससक ववकास एविं स्रोतों 
की िािकारी 

 

२ सरल, सिंयकु्त और समश्र वाक्य रचिा का अध्ययि एविं सिंवाद अभ्यास  

३ अिंगे्रजी से ह िंदी में अिवुाद – सरल वाक्यों पर आधाररत  

४ ह िंदी से अिंगे्रजी में अिवुाद – लघ ुअिचु्छेदों पर आधाररत 
 

५ औपचाररक पत्र लेखि – अवकाश आवेदि, निवेदि पत्र आहद 
 

६ अिौपचाररक पत्र लखेि – समत्र, पररवार आहद को पत्र 
 

७ अिचु्छेद लेखि  /सार लेखि ( 100–150 शब्दों में)  

८ ररपोिज लखेि – कायजक्रम, समाचार अिवा गनतववधध पर आधाररत 
 

९ 
सिंवाद लेखि – ववसभन्ि सामात्िक अिवा व्यावसानयक पररत्स्िनतयों पर 
आधाररत 

 

१० 
वाचि अभ्यास – शदु्ध उच्चारण, ववराम धचन् ों का प्रयोग, शब्द सिंग्र  का 
ववस्तार 

 

११ सिंभाषण  /भसूमका-निमाजण ( Role-play) – साक्षायकार, सिंवाद, सम ू चचाज आहद 
 

१२ 
अिंनतम प्रयोगायमक परीक्षा – आिंतररक मलू्यािंकि  +मौणखक परीक्षा ( Viva 

Voce) 

 

 

संदभण गं्रथ (Reference Books): 

1. द्दहदंी भाषा का उद्भव और ववकास – डॉ.  रीशचिंद्र वमाज 
2. द्दहदंी भाषा का इततहास – डॉ. रामववलास शमाज 
3. भारत में राजभाषा द्दहदंी – डॉ. ववचविाि प्रसाद 

4. द्दहदंी व्याकरर् और रचना – डॉ.  रीशचिंद्र वमाज 
5. द्दहदंी लेखन कौशल – डॉ. रमेश गुप्ता 
6. अनुवाद ववज्ञान और ससद्ांत – डॉ. ओमप्रकाश 
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Teaching 

Scheme 

Modern Indian Languages 

Sanskrit (संस्कृत) 
Course code: 25AF1246AEL308C 

Examination 

Scheme 

TH - पाठ्यक्रम उिेश्य (Course Objectives): 
1. सिंस्कृत भाषा के ऐनत ाससक प्रवास की समझ देिा। 
2. सिंस्कृत लेखि के नियम एविं व्याकरण का अभ्यास करािा। 
3. दैनिक सिंवाद  ेतु आवचयक शब्दों का अध्ययि करािा। 

अपेक्षित पाठ्यपररर्ाम (Course Outcomes - COs): 
CO1: ववद्यािी सिंस्कृत भाषा के ऐनत ाससक प्रवास को समझेंगे एविं उसके 

ववकास के चरणों को स्पष्ट्ि कर सकें गे। 
CO2: शुद्ध और प्रमाणबद्ध सिंस्कृत लेखि करिे की क्षमता प्राप्त करेंगे। 
CO3: ववसभन्ि लेखि शैसलयों को आयमसात कर लेखि कर सकें गे। 
CO4: स्पष्ट्ि और सिीक भाषा में सिंस्कृत से अन्य भाषाओिं में तिा अन्य 

भाषाओिं से सिंस्कृत में प्रभावी अिुवाद कर सकें गे। 

CA 60 

PR 2 ESE 40 

CR 1 TOTAL 100 

   

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 2 - - - - 2 - - - 2 - 2 - - 1 

CO2 2 - 1 - 1 - - - 1 2 - 2 - 1 1 

CO3 - - 1 - 2 - - - 2 2 - 2 - 1 2 

CO4 1 - 2 - 2 2 - 2 2 3 - 2 1 2 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs: 1–Low, 2– 

Medium, 3–High. 
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प्रयोग अभ्यासक्रम 

 

सप्ताह प्रयोगात्मक अभ्यास 
 

१      सिंस्कृत भाषा का पररचय, इनत ास एविं म यव  

२      वणजमाला – स्वर, व्यिंिि, उच्चारण एविं सलवप  

३      सिंज्ञा, सवजिाम, सलिंग, वचि, पुरुष का अभ्यास  

४      क्रक्रया, काल, सिंधध और कारक का पररचय  

५      ववभत्क्त प्रयोग एविं वाक्य निमाजण  

६      शब्द सिंग्र  – पररवार, प्रकृनत, पशु, वस्तुएँ  

७      असभवादि एविं सामान्य सिंवाद वाक्य  

८      सरल वाक्य निमाजण का अभ्यास  

९      सिंस्कृत चलोकों / सुभावषतों का पाठ एविं अिज  

१०      पिंचतिंत्र, ह तोपदेश, गीता से चयनित चलोक अभ्यास  

११      सिंस्कृत अिुच्छेद लेखि एविं पाठ अभ्यास  

१२      अिंनतम प्रयोगायमक परीक्षा + मौणखक परीक्षा  

 

संदभण गं्रथ (Reference Books): 

1. संस्कृत व्याकरर् सारांश – वासुदेव द्वववेदी 
2. भाषा ववज्ञान और संस्कृत भाषा – डॉ. सययव्रत शमाज 
3. संस्कृत संवाद कौशल – डॉ. मीरा त्रत्रपाठी 
4. द्दहटोपदेश, पंचतंत्र, श्रीमद्भगवद्गीता – चयनित चलोक 

5. संस्कृत सुभावषत संग्रह – भारती साह यय. 

7. NPTEL/SWAYAM Digital Reference : 

https://onlinecourses.nptel.ac.in/noc21_hs03/preview 
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Teaching 

Scheme 

IT Project Management (ITPM) 

Course code: 25AF1246HM309 

Examination 

Scheme 

TH 2 Prerequisite Courses:  

1. Design Thinking 

Course Objectives: 

1. To understand the fundamentals of IT project management, 

including the project life cycle, business case development, and  

project selection methods. 

2. To develop skills in project scope definition, scheduling, budgeting, 

and risk management. 

3. To learn effective communication planning, procurement processes, 

and outsourcing strategies in IT projects. 

4. To explore leadership qualities, ethical practices, and mplementation 

strategies for successful project closure. 

Course Outcome :  

After successful completion of the course, students will be able to: 

CO1: Explain the IT project life cycle, business case preparation, and 

project selection techniques. 

CO2: Analyze and prepare a project scope, schedule, and budget with 

appropriate risk management strategies. 

CO3: Develop project communication and procurement plans, and 

evaluate outsourcing strategies. 

CO4: Demonstrate leadership, teamwork, and ethical behavior in 

managing multicultural and IT project teams. 

CO5: Apply concepts of project execution, monitoring, and closure with 

appropriate evaluation methods. 

CA 20 

PR - MSE 20 

CR 2 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO
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PO
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PO

3 

PO
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PO
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PO
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9 

PO

10 

PO

11 

PO
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O1 
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O2 
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CO1 2 
 

2 
 

1 
 

- - - - - 2 
 

2 
 

- 2 
 

- - - 

CO2 3 
 

3 
 

2 
 

2 
 

2 
 

- - - 1 
 

3 
 

- 3 
 

2 
 

- - 

CO3 - 1 
 

2 
 

2 
 

- 2 
 

2 
 

- 1 
 

2 
 

3 
 

- 2 
 

2 
 

2 
 

CO4 - - - - - 2 
 

3 
 

3 
 

2 
 

- - - - 3 
 

- 

CO5 2 2 2 2 2 - - - 2 3 2 2 2 2 2 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 
 

Unit 

No. Topic Hours 

1 
An overview of IT project management: Introduction, The state of IT project 

management, The context of  project management, Project Life Cycle and IT 

Development. The Business Case: Introduction, an ITPM , Business case, Project 

selection and Approval. 

06 Hrs 

2 
The Project Team: Introduction, Organization and Project Planning, The project 

team, The project Evaluation. The scope management plan: Introduction, Scope 

planning, Project scope definition, Project scope verification. 

06 Hrs 

3 
The Project’s Schedule and Budget: Developing the project’s Schedule, 

Developing  Project Budget, Finalizing the project schedule and budget. The Risk 

management Plan: IT project Risk management Planning Process, Identifying IT 

Project Risk, Risk analysis and assessment. 

06 Hrs 

4 
The Project communication plan: Monitoring and controlling the project, The 

Project communication plan, Project Metrics, Managing Project procurement and 

Outsourcing: Project procurement management. 

06 Hrs 

5 
Project Leadership and Ethics: Project Leadership, Ethics in Projects, 

Multicultural Projects. The implementation Plan and Project closure: Project 

Implementation, Administrative Closure, Project Evaluation. 

06 Hrs 

 Text Book: 
1. Jack T. Marchewka, Information Technology Project Management, 5th 

Edition, Wiley India. ISBN: 9788126557873. 

 Reference Books: 
1. Kathy Schwalbe, Information Technology Project Management, 7th 

Edition, Cengage Learning. ISBN: 9788131520972. 

2. Wade Golden, Project Management, Bravex Publications, January 2020. 

ISBN 978-1647482602. 

 

Alternative NPTEL/SWAYAM Digital Reference 

Sr.No. 
NPTEL/SWAYAM 

Courses Name 
Instructor Host Institute Links 

01 Software Project 

Management 

 

Prof. Rajib Mall, 

Prof. Durga 

Prasad 

Mohapatra 

IIT Kharagpur, 

NIT Rourkela 

https://onlinecourses.nptel.ac.in/n

oc22_cs107/preview 

 

 Back to Index 
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Teaching 

Scheme 

Life of Chhatrapati Shivaji Maharaj 

Course code: 25AF1000VE310A 

 

Examination 

Scheme 

TH 1 Course Objective: 

1. Analyze Chhatrapati Shivaji Maharaj's leadership qualities, 

strategic thinking, and management skills. 

2. Develop critical thinking and problem-solving skills through case 

studies and discussions. 

3. Recognize the relevance of the Chhatrapati's principles and values 

in modern times. 

Course Outcomes: 

After successful completion of this course the student will be able: 

CO1: Explain Chhatrapati Shivaji Maharaj's military strategies, 

conquests, and establishment of the Maratha Empire. 

CO2: Evaluate the Chhatrapati's leadership qualities, such as courage, 

vision, human values and adaptability. 

CO3: Apply the Chhatrapati's principles, such as decentralization and 

social welfare, to modern engineering challenges. 

CA 60 

PR - ESE 40 

CR 1 TOTAL 100 

    

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO
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PO
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PO
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O2 
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CO1 2 - - - - 3 2 - 2 2 - 2 - - 2 

CO2 1 - - - - 2 1 3 3 2 - 2 - - 3 

CO3 2 - - - - 3 3 3 3 2 - 3 - - 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 
Shivaji Maharaj as a Great Conqueror: Master Strategist and innovator in 

Military Tactics, Guerrilla Warfare (Ganimi Kava), Fortress Strategy, Avoidance 

of Direct Confrontation, Diplomacy and Alliances, Naval Power. 

5 Hrs 

2 
Shivaji Maharaj's Management and leadership strategies: Architecture and 

metallurgy of Raigad Fort, Use of Light Cavalry, Intelligence Network, 

Asymmetric Warfare, Logistics and Supply Chains, Fortifications and Military 

Architecture. 

5 Hrs 

3 
Shivaji Maharaj’s views on Democracy and Nationalism:Shivaji Maharaj’s 

views about Women's rights, their dignity and religious views, His views on 

Democracy & Nationalism. 

5 Hrs 

  Textbooks: 

1. Desai, Ranjit, Shriman Yogi, Mehta Publishing House, 2018. 

2. Kurundkar, Narhar, Chatrapati Shivaji Maharaj Jeevan Rahasya, 

Deshmukh and Company, 2024. 

3. Sarkar, Jadunath, Shivaji and His Times, Nandy Books, 2024. 

 Reference Books: 

1. Keluskar, Krushnaji Arjun, Chhatrapati Shivaji Maharaj, Sudhir 

Prakashan, 2020. 

2. Bedekar, Ninad, Kalatil Vyavsthapan Tatve, 2015. 

 

 

 

 

 

 

 
Back to Index 
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Teaching 

Scheme 

Community Engagement Project/Field Project 

Course code: 25AF 1246CP311 

Examination 

Scheme 

4 Hrs / Week 

= Credit 2 
Prerequisite Courses:  

1. Fundamentals of Communication Skills 

2. Design Thinking / Problem Solving Techniques 

Course Objective: 

1. To provide students with experiential learning opportunities 

through community-based field projects. 

2. To develop an understanding of socio-economic challenges faced 

by local communities. 

3. To encourage students to apply their technical knowledge to real-

world community issues. 

4. To promote a sense of civic responsibility and ethical engagement 

in students. 

5. To enhance students' problem-solving, teamwork, communication, 

and leadership skills through active participation in community 

work. 

Course Outcomes: 

After successful completion of this course the student will be able: 

CO1: Identify and analyze real-life socio-economic issues through field-

based learning experiences. 

CO2: Apply knowledge from core courses to propose context-specific 

and sustainable solutions to community problems. 

CO3: Work effectively in teams to plan, implement, and evaluate a 

community engagement project under faculty supervision. 

CO4: Demonstrate social responsibility, ethical behavior, and empathy 

while working with diverse community stakeholders. 

CO5: Communicate project goals, processes, and outcomes clearly 

through presentations, reports, and community interactions. 

CA 40 

ESE 60 

TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 

PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 2 3 2 2 1 3 2 2 2 2 1 2 2 1 2 

CO2 3 3 3 2 2 3 3 2 2 2 1 2 3 2 2 

CO3 2 2 3 1 2 2 2 2 3 2 2 2 2 2 3 

CO4 1 1 2 1 1 3 3 3 2 2 1 2 2 1 3 

CO5 1 1 2 1 1 2 2 2 2 3 1 2 1 1 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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Syllabus of SEMESTER-IV Courses 

Teaching 

Scheme 
Analysis of Algorithms 

Course code: 25AF1246PC401 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

1. Data Structures 

2. Programming for Problem Solving 

Course Objectives: 

1. The principle objective of this course is to build solid foundation 

in algorithms and their applications.  

2. To implement various divide and conquer techniques examples.  

3. To implement various Greedy techniques examples.  To 

implement various Dynamic Programming techniques examples. 

4. To provide a practical exposure of all algorithms.  

5. To understand the importance of algorithm and its complexities.  

Course Outcomes (COs): 

Course Outcomes: Upon successful completion of this course, students 

will be able to:  

CO1: Students will be able to calculate the time complexity of 

algorithm.  

CO2:  Students will be able to sort the given numbers using various 

sorting algorithms.  

CO3: Students will be able to write programs for the problems using 

Divide and Conquer. 

CO4: Students will be able to write programs for the problems using 

Greedy Method. 

CO5:  Students will be able to write programs for the problems using 

Dynamic programming and backtracking. 

 

CA 20 

PR 1 MSE 20 

CR 4 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 3 3 3 1 2 1 1 2 1 - 1 1 2 - 

CO2 3 2 2 3 2 1 2 1 1 - - - 2 2 - 

CO3 3 3 2 3 3 1 1 1 - - - - 1 3 1 

CO4 3 3 2 3 2 1 2 1 - - - - 1 3 1 

CO5 3 3 3 3 3 2 3 1 - - - - 3 3 1 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Introduction: Instruction counts, Growth functions, Necessity of time and space 

analysis of algorithms, Order notations (O, Θ, Ω notations), Different types of 

method for solving recurrence relations: Substitution method, Master theorem 

method, Recurrence tree method. 

07 Hrs 

2 Divide and Conquer: Binary search, Finding maximum and minimum, Merge 

sort, Quick sort, Strassen’s matrix multiplication. 

Greedy Algorithms: Knapsack problem, Job sequencing with deadlines, 

Optimal storage on tapes, Optimal merge pattern, Single source shortest paths. 

07 Hrs 

3 Dynamic Programming: Multistage graphs, All pair’s shortest paths, Knapsack 

problem, Travelling Salesperson Problem, Longest Common Subsequence. 

07 Hrs 

4 Graph Theory: Elementary Algorithms: DFS, BFS And Topological Sort, 

Minimum spanning trees (Kruskal’s and Prim’s algorithms). 
07 Hrs 

5 Introduction to Backtracking and Branch and bound strategy: N-queen 

problem, Sum of Subsets, Graph Coloring.  

NP theory: Basic concepts, Reduction process, Relation of P, NP Hard and NP 

complete problems. 

07 Hrs 

 Text Books: 

1. Thomas Cormen, Charles Leiserson, Ronald Rivest, and Clifford Stein, 

Introduction to Algorithms, MIT Press, 3rd Edition, 2010. 

2. E. Horowitz, S. Sahni, and S. Rajsekaran, Computer Algorithms, Silicon 

Press, 2nd Edition, 2008. 

 Reference Books: 

1. B. K. Joshi, Data Structures and Algorithms in C++, Tata McGraw Hill 

Education, 2010. 

2. G. T. Heineman, Gary Pollice, Stanley Selkow, Algorithms in a Nutshell, 

Shroff Publication, 2nd Edition, 2016. 

3. Kyle Loudon, Mastering Algorithms with C, O’Reilly Publication, 1st 

Edition, 2009. 

4. S. K. Basu, Design Methods and Analysis of Algorithm, PHI. 
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Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No. NPTEL/SWAYAM 

Courses Name 

Instructor Host Institute Links 

01 Design and 

Analysis of 

Algorithms 

 

Prof. Abhiram G Ranade, 

Prof. Ajit A Diwan, Prof. 

Sundar Viswanathan 

IIT Bombay 

 

https://nptel.ac.in/courses/1061

01059 

02 Design and 

Analysis of 

Algorithms 

Prof. Madhavan Mukund Chennai 

Mathematical 

Institute 

 

https://nptel.ac.in/courses/1061

06131 

03 Design and 

Analysis of 

Algorithms 

 

Dr Akshay Kumar  Indira Gandhi 

National Open 

University, 

New Delhi 

https://onlinecourses.swayam2.

ac.in/nou25_cs31/preview 
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Teaching 

Scheme 

Analysis of Algorithms Lab 

Course code: 25AF1246PCL402 

Examination 

Scheme 

2 Hrs / Week 

= Credit 1 Course Outcomes (COs): 

After pursuing the course, the students will be able to: 

CO1: Implement searching and sorting algorithms using Divide and 

Conquer approach and analyze their time complexity. 

CO2: Apply Greedy strategy to solve optimization problems like the 

Knapsack problem. 

CO3: Design solutions using Dynamic Programming for complex 

problems including cost optimization and Knapsack. 

CO4: Solve problems using Graph algorithms such as Topological Sort 

and understand their applications. 

CO5: Apply Backtracking to solve constraint satisfaction problems like 

the N-Queen problem and analyze algorithm behavior. 

CA 60 

ESE 40 

TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 2 2 2 3 - - - - - - 1 3 3 - 

CO2 3 3 2 2 3 - - - - - - 1 3 3 - 

CO3 3 3 3 2 3 - - - - - - 1 3 3 - 

CO4 3 3 2 3 3 - - - 1 - - 1 3 3 - 

CO5 3 3 3 3 3 - - - - - - 1 3 3 - 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 

 
List of Experiments: 

1. Write a program for searching an element from the given 

sorted array of size ‘n’ by using binary search algorithm and 

apply divide and conquer approach. 

2. Write a program for sorting an unsorted array with size as ‘n’ 

by using Merge Sort algorithm and also analyse the time 

complexity in worst case, average case and best case. 

3. Write a program for sorting an unsorted array with size as ‘n’ 

by using Quick Sort algorithm and also analyse the time 

complexity in worst case, average case and best case.  

4. Write a program for finding the maximum and minimum 
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elements from the given array of size ‘n’. 

5. Write a program to implement the Knapsack problem using 

Greedy method and earn the maximum profit. 

6. Write a program to implement the Knapsack problem using 

Dynamic Programming method and earn the maximum profit. 

7. Write a program to implement the Knapsack problem using 

Dynamic Programming method and earn the maximum profit 

by generating the cost. 

8. Write a program for Topological Sort for getting the ordering 

of given graph.  

9. Write a program for different sorting algorithm. 

10. Write a program for N queen problem and demonstrate its 

illustration. 

 

Note: 

1. The above list is for illustration purposes only. The course coordinator 

may update or change the list as needed, 

2. At least 8 to10 experiments should be performed. 

3. Students should be encouraged to design and perform new experiments, 

subject to prior approval from the respective subject authority. 
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Teaching 

Scheme 

Computer Organization and Architecture 

Course code: 25AF1246PC403 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

1. Digital Logic Design  
2. Fundamentals of Computer Programming  

Course Objectives: 

1. To understand the structure, function & characteristics of 

computer systems.  

2. To understand the design of the various functional units and 

components of digital computers 

3. To study hierarchical memory system including cache memories 

and virtual memory.  

4. To understand instruction level parallelism & parallel 

organization of multi-processor & multi core systems 

 Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Explain processor structure & its functions. 

CO2: Solve problems based on computer arithmetic.  

CO3: Understand concepts related to memory & IO organization. 

CO4: Obtain knowledge about micro-programming of a processor. 

CO5: Acquire knowledge about instruction level parallelism & parallel 

organization of multiprocessors & multi core systems. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 2 - - 2 - - - - - - 1 3 2 - 

CO2 3 3 2 - - - - - - - - 1 3 3 - 

CO3 3 2 - - 3 - - - - - - 1 3 3 - 

CO4 3 2 2 - 3 - - - - - - 1 2 3 - 

CO5 3 2 2 - 3 - - - - - - 2 2 3 2 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. 
Topic Hours 

1 Introduction: Concept of computer organization and architecture, 

Fundamental unit, Computer function and interconnection, CPU structure and 

function. 

07 Hrs. 

2 Instruction Sets: Characteristics, Types of operands, Types of operations, 

Assembly language, Addressing modes, Instruction format, Types of 

instruction, Instruction execution, Structure of program, Introduction to RISC 

and CISC architecture.  

Computer Arithmetic: The arithmetic and logic Unit, Integer representation, 

Integer arithmetic, Floating point representation, Floating point arithmetic. 

08 Hrs. 

3 Memory Organization: Internal Memory: Semiconductor main memory, Error 

detection & correction, Advanced DRAM organization, Virtual memory 

systems and cache memory systems, External Memory: Organization and 

characteristics of magnetic disk, Magnetic tape, Optical memory, RAID. 

07Hrs 

4 Control Unit: Control unit operation: Micro-operations, Control of the 

processor, Hardwired implementation Control Unit, Micro-programmed Control 

Unit. 

07Hrs 

5 Input/ Output Organization: External devices, I/O module, Programmed I/O, 

Interrupt driven I/O, Direct memory access. Instruction pipe-lining: Concepts, 

Parallel processing: Multiple processor organization, Symmetric 

multiprocessor, Cache coherence and the MESI protocol. 

08 Hrs. 

 
Text Books: 

1. William Stalling, Computer Organization and Architecture: Designing 

for Performance, Prentice Hall Publication, 8th Edition, 2009. 

2. Hayes, Computer Architecture and Organization, McGraw-Hill 

Publication, 3rd Edition, 2012. 

3. Zaky, Computer Organization, McGraw-Hill Publication, 5th Edition, 

2011. 

Reference Books: 

1. Morgan, Hennessy, Patterson, Computer Architecture: A Quantitative 

Approach, Kaufman Publication, 4th Edition, 2007. 

2. Morris Mano, Computer System Architecture, Pearson Education India, 

3rd Edition, 2007. 

3. Mostafa Abd-El-Barr, Hesham El-Rewini, Fundamentals of Computer 

Organization and Architecture, Wiley Publication, 1st Edition, 2004. 
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4. Miles J. Murdocca, Vincent P. Heuring, Computer Architecture and 

Organization: An Integrated Approach, Wiley Publication, 1st Edition, 

2007. 

 

Alternative NPTEL/SWAYAM Digital Reference 

 

Sr.No. NPTEL/SWAYA

M Courses Name 

Instructor Host Institute Links 

01 Computer 

Organization and 

Architecture 

Prof. V. Kamakoti IIT Madras 

 

https://nptel.ac.in/courses/106106
166 

02 Computer 

Organization and 

Architecture 

Prof. Jatindra 
Kumar Deka 

IIT Guwahati 
 

https://nptel.ac.in/courses/106103
068 
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Teaching 

Scheme 
Discrete Mathematics 

Course code: 25AF1246PC404 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

1. Fundamentals of Mathematics 

2. Introduction to Computer Programming 

Course Objectives: 

1. Understand basic discrete structures like sets, functions, and 

relations. 

2. Apply logic and proof techniques to solve mathematical and 

computational problems. 

3. Use counting principles and recurrence to handle combinatorial 

problems. 

4.  Explore algebraic structures and graph theory for real-world IT 

applications. 

5. Develop logical reasoning and problem-solving skills for advanced 

computing. 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Apply set theory and logic to real-world computing problems. 

CO2: Use induction and recursion in algorithmic problem solving. 

CO3: Apply counting techniques and solve recurrence relations. 

CO4: Analyze and apply relations and algebraic structures in 

computation. 

CO5: Utilize graph theory concepts in modeling and solving IT-based 

problems. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 

PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 3 2 2 1 2 - - - - 1 - 2 3 2 - 

CO2 3 3 2 2 2 - - - - - - 2 3 2 - 

CO3 3 3 3 2 2 - - - - - - 2 3 3 - 

CO4 3 2 2 1 2 1 - 1 - - - 2 3 2 2 

CO5 3 3 3 2 3 - 1 - 1 1 1 3 3 3 2 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1  Sets and Logic:Set operations, power sets, partitions, cardinality ,Inclusion-

exclusion principle and applications. Propositional and predicate logic, logical 

operations, quantifiers.Rules of inference, proof strategies, applications in web 

search & bitwise operations. 

07 Hrs 

2 Induction, Recursion, and Functions : Mathematical & strong  induction, 

Recursive definitions and algorithms. Types of functions: injective, surjective, 

bijective .Composition, identity, inverse, and recursive functions .Application: job 

scheduling. 

07 Hrs 

3 Counting and Recurrence : Permutations, combinations (with/without 

repetition). Binomial coefficients and pigeonhole principle. Generating 

permutations, solving recurrence relations. Applications: basic combinatorics and 

enumeration. 

07 Hrs 

4 Relations and Algebraic Structures : Binary relations, closures, equivalence & 

partial orders. Warshall’s algorithm, N-ary relations and their applications, , 

Databases and relations.. Algebraic systems: groups, monoids, rings, fields. Codes, 

Homomorphism, Fermat’s theorem, polynomial rings, Applications of groups, 

Ring, Field. 

07 Hrs 

5 Graph Theory : Graphs: types, paths, circuits, Euler & Hamiltonian paths . Graph 

coloring, independent sets, planar graphs, Trees, spanning trees, cut sets, MST 

algorithms: Kruskal’s and Prim’s ,Applications: TSP, shortest path algorithms. 

07 Hrs 

 
Text Books: 

1. Rosen, K. H., “Discrete Mathematics and Its Applications”, 8th Edition, 

Tata McGraw Hill Publication, 2018. 

2. Tremblay, J. P., and Manohar, R., “Discrete Mathematical Structures with 

Applications to Computer Science”, 1st Edition, McGraw Hill Publication, 

2001. 

3. Liu, C. L., “Elements of Discrete Mathematics”, 3rd Edition, McGraw-

Hill Publication, 2008. 

Reference Books: 
1. Kolman, B., Busby, R., and Ross, S., “Discrete Mathematical Structures”, 

6th Edition, Pearson Education, 2009. 

2. Bisht, R. K., and Dhami, H. S., “Discrete Mathematics”, Oxford 

University Press, 2015. 
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Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No

. 

NPTEL Courses 

Name 

Instructor Host Institute Links 

01 Discrete Mathematics 

 

Prof. Ashish 

Choudhury 

IIIT Bangalore https://onlinecourses.nptel.ac.in/noc

25_cs127/preview 

02 Discrete Mathematics 

 

Prof Sudarshan 

Iyer 

IIT Ropar, https://onlinecourses.nptel.ac.in/noc

25_cs105/preview 
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Teaching 

Scheme 

Web Technology 

Course code: 25AF1246VSL407 

Examination 

Scheme 

TH 1 Prerequisite Courses:  

1. Computer Fundamentals 

2. Programming for Problem Solving 

Course Objectives: 

1. To provide an introduction to the concepts of web development using 

HTML, CSS, and PHP. 

2. To develop the ability to design and structure web pages using HTML 

and styling with CSS. 

3. To implement server-side scripting using basic PHP. 

4. To build dynamic web pages through form processing and session 

handling. 

5. To introduce the concept of website hosting and deployment. 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1. Design static web pages using HTML. 

CO2. Apply CSS to enhance the design and responsiveness of web          

pages 

CO3. Develop simple dynamic web pages using PHP. 

CO4. Implement form data handling and validations using PHP. 

CO5. Deploy websites using basic hosting techniques and tools. 

CA 60 

PR 1 MSE - 

CR 2 ESE 40 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 1 2 2 1 2 1 1 1 1 1 2 1 1 2 1 

CO2 2 1 3 1 3 1 1 1 1 2 1 1 3 3 1 

CO3 3 2 3 2 3 1 1 1 1 2 2 1 3 3 2 

CO4 2 2 3 2 2 2 1 1 1 2 2 1 3 3 3 

CO5 3 2 2 1 3 2 2 2 1 2 1 2 3 3 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

Unit 

No. Topic Hours 

1 Web Basics and HTML :Web Fundamentals: WWW, HTTP, URL, Web Client and 

Server, Basic HTML: HTML Structure, Headings, Paragraphs, Lists, Tables, 

Hyperlinks, Forms Basics: Input types (text, radio, checkbox), Labels, Buttons. 

04 Hrs 

2 Advanced HTML & CSS : HTML Advanced Elements: Select, Textarea, File 

upload, HTML5 Semantic Tags: <section>, <article>, <nav>, <aside>, Multimedia 

Embedding: Audio, Video, iFrames, Introduction to CSS: Syntax, Selectors, Types 

(Inline, Internal, External), Styling Basics: Colors, Fonts, Backgrounds, Box Model, 

Layout Techniques: Float, Basic Flexbox 

05  Hrs 

3 PHP & Website Hosting : PHP Basics: Syntax, Variables, Data Types, Operators, 

Conditional Statements, Loops, Form Handling: $_GET, $_POST methods, 

Connection with database, CRUD  Operation in PHP , basic file operations, 

Introduction to Sessions and Cookies, Website Hosting: Overview of domain and 

hosting, deploying using free platforms (e.g., GitHub Pages, 000WebHost) 

06 Hrs 

 Text Books 
1. Jon Duckett, HTML & CSS: Design and Build Websites. John Wiley & 

Sons, 2011. ISBN: 978-1-118-00818-8. 

2. Larry Ullman, PHP for the Web: Visual QuickStart Guide, 5th Edition. 

Peachpit Press, 2016. ISBN: 978-0-13-429125-3. 

Reference Books 
1. Robin Nixon, Learning PHP, MySQL & JavaScript: With jQuery, CSS & 

HTML5, 5th Edition. O’Reilly Media, 2018. ISBN: 978-1-492-04114-8. 

2. Uttam K. Roy, Web Technologies: HTML, JavaScript, PHP, Java, JSP, 

XML and AJAX, Black Book. Oxford University Press, 2010. ISBN: 978-0-

19-806622-1. 

List of Experiments: 

1. Create a simple HTML page with headings, paragraphs, and line breaks. 

2. Design a student registration form using HTML elements. 

3. Create a web page using HTML tables for timetable display. 

4. Develop a web page with navigation links and embedded video. 

5. Apply internal and external CSS to a web page. 

6. Create a responsive page using Flexbox or Grid. 

7. Write a PHP script to demonstrate arithmetic and logical operators. 

8. Create a PHP program to handle form data and display submitted input 

9. Preform crud operation using PHP and MySQL. 

10. Develop a login form using HTML and validate using PHP. 

11. Perform file handling operations in PHP. 

12. Host a sample static website using GitHub Pages or free web hosting 

tool. 

Note: 

1. The above list is for illustration purposes only. The course coordinator may update 

or change the list as needed, 

2. At least 8 to10 experiments should be performed. 

3. Students should be encouraged to design and perform new experiments, subject to 

prior approval from the respective subject authority. 
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Teaching 

Scheme 

Innovation and Entrepreneurship 

Course code: 25AF1246HM408 

Examination 

Scheme 

TH 2 Prerequisite Courses: 
1. Design Thinking / Creative Problem-Solving  

2. Communication Skills  

Course Objectives: 

1. To study and understand the key concepts of innovation and 

entrepreneurship principles and the role of innovation in business 

success. 

2. To cultivate the ability to generate and evaluate innovative ideas 

through creative thinking techniques and design thinking 

methodologies. 

3. To learn to design viable business models and value propositions 

those effectively address market needs and customer problems. 

4. To acquire practical skills in opportunity recognition, risk 

assessment, resource mobilization, and lean start-up methodologies 

for launching and managing new ventures.  

 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1. Outline the concepts of Entrepreneurship. 

CO2. Create the awareness on creativity and innovation. 

CO3. Adapt the Entrepreneurship development program. 

CO4. Evaluate the project planning and feasibility studies. 

CO5. Analyze the concept of small and micro enterprise. 

CA 60 

PR - MSE - 

CR 2 ESE 40 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 1 1 - - - 2 - - - - 2 2 2 2 2 

CO2 1 1 - - - 2 - - - - 2 2 2 2 2 

CO3 2 2 - - - 2 - - - - 2 2 2 2 2 

CO4 2 2 - - - 2 - - - - 3 3 3 2 2 

CO5 2 2 - - - 2 - - - - 3 3 3 2 2 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Introduction to Innovation and Entrepreneurship: Defining innovation, 

Types of innovation: incremental, radical, disruptive, The innovation process, 

Factors that drive innovation, Defining entrepreneurship, The entrepreneurial 

process, Characteristics of successful entrepreneurs, Brainstorming, Design 

thinking process. 

07 Hrs 

2 Opportunity identification and Idea Generation: Techniques for Identifying 

Business Opportunities, Creativity and Innovation in Entrepreneurship, 

Evaluating Feasibility and Potential of Business Ideas, Tools for Idea Generation: 

Customer value propositions- Business models. 

07 Hrs 

3 Business Planning and Strategy Development: Importance of a Business Plan, 

Components of a Business Plan: Executive Summary, Market Research, 

Marketing Strategy, Operational Plan, Developing Financial Projections 

(Revenue, Cost, Profit), Strategic Planning and Goal Setting, Business Model 

Design (e.g., B2B, B2C, SaaS). 

07 Hrs 

4 Business Organization and Venture Establishment: Forms of business 

organization, techno- economic feasibility assessment, financial feasibility, 

Market feasibility, preparation of business plan, business canvas & lean canvas, 

challenges and pitfalls in selecting new venture. 

07 Hrs 

5 Promoting and managing innovation: Sources of finance: crowdfunding, 

venture capital, equity funds, angel investing; various forms of IPR: patent, 

copyright, trademark, geographical indications, industrial design; Enhancing 

innovation potential & formulating strategies for innovation. 

07 Hrs 

 Text Books: 
1. Charanthimath, Poornima M., Entrepreneurship Development and Small 

Business Enterprises, Pearson Education,2016 . 

2. Pavan Soni, Design Your Thinking – The Mindsets, Toolsets and Skill 

Sets For Creative Problem Solving, Penguin Random House India Pvt. 

Ltd., 2020. ISBN: 9780670094097. 

Reference Books: 
1. Pearson Education, Entrepreneurship and Small Business Management, 

2nd Edition. Pearson, July 14, 2021. ISBN-13: 978-0137612468. 

2. Hatten, T. S., Small Business Management: Entrepreneurship and 

Beyond, 5th Edition, Cengage Learning, 2012. 

3. Hisrich, R. D., Peters, M. P., & Shepherd, D. A., Entrepreneurship, 10th 

Edition, McGraw-Hill Education, 2017. 

4. Drucker, P. F., Innovation and Entrepreneurship, Routledge, 2014. ISBN: 

9781138019195. 

5. McGrath, R. G., & MacMillan, I. C., The Entrepreneurial Mindset: 

Strategies for Continuously Creating Opportunity in an Age of 

Uncertainty, Harvard Business School Press, 2000. ISBN: 

9780875848341. 
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Teaching 

Scheme 

Life of Bharat Ratna Dr Babasaheb Ambedkar 

Course code: 25AF1000VE409B 

Examination 

Scheme 

TH 1 
Course Objective: 

1. To analyze Dr. Ambedkar's role in shaping India's constitution and 

social justice movements. 

2. To recognize the relevance of his principles in contemporary 

engineering and societal contexts. 

3. To develop critical thinking and problem-solving skills through case 

studies and discussions. 

Course Outcomes: 

After successful completion of this course the student will be able: 

CO1: To explain Dr. Ambedkar's key contributions to the Constitution of India, 

establishment of human values and social reform. 

CO2: To identify and analyze his leadership qualities and strategic thinking. 

CO3: To evaluate the impact of his legacy on Maharashtra's culture, politics, 

and economy. 

CA 60 

PR - ESE 40 

CR 1 TOTAL 100 

    

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO

1 

PO
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PO

3 

PO

4 

PO
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PO
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PO
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PO

8 

PO
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PO
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PO
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PS

O1 

PS

O2 

PSO
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CO1 1 2 - - - 3 - 2 - - - - - - 2 

CO2 - 2 2 - - 3 - 2 2 2 - - - - - 

CO3 - 2 - - - - - 2 - - - - - - 2 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 
Introductio: Introduction to the Socio-political Context of Dr. Babasaheb 

Ambedkar's Era, British Colonialism, Indian National Movement, Caste 

Hierarchy, Untouchability, Social Reform Movements, Role in the Indian 

freedom struggle. 

5 Hrs 

2 
The Contribution of Dr. Babasaheb Ambedkar: Contributions to the 

Constitution of India, Vision for Social Justice and Empowerment. 

5 Hrs 

3 
Legacy and Relevance Today: Dr. Ambedkar and Marxism: An Exploration of 

his Thoughts on Marxism, Common Ground with Marxism, Focus on Class 

Struggle, Caste Vs Caste, Primacy of Caste in Indian Society, Economic Ideas 

and Policies. 

5 Hrs 

 Textbooks: 

1. Keer, Dhananjay, Dr. Babasaheb Ambedkar: Life and Mission, Popular 

Prakashan, 1954. 

2. Ambedkar, B. R., Annihilation of Caste, Fingerprint Publishing, 2023. 

Reference Books: 

1. Ambedkar, B. R., Buddha or Karl Marx, Infinite Words, 2024. 

2. Ambedkar, B. R., The Problem of Rupee: Its Origin and Its Solution, 

Sudhir Prakashan, 2021. 
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Teaching 

Scheme 

UHV-II 

Course code: 25AF1000VE410C 

Examination 

Scheme 

TH 2 Course Objectives: 

1. To help the students appreciate the essential complementarity 

between 'VALUES' and 'SKILLS' to ensure sustained happiness and 

prosperity, the core aspirations of all human beings. 

2. To facilitate the development of a holistic perspective among students 

towards life and profession as well as happiness and prosperity, 

based on correct understanding of human reality and the rest of 

existence. 

3. To highlight implications of such a holistic understanding in terms of 

ethical human conduct, fulfilling human behavior, and enriching 

interaction with Nature. 

 Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1:  Become more aware of themselves, and their surroundings 

(family, society, nature). 

CO2: Act more responsibly in handling problems with sustainable 

solutions, considering human relationships and nature. 

CO3: Develop sensitivity and commitment toward human values, 

relationships, and society. 

CO4: Apply learned values in real-life scenarios and day-to-day decision-

making. 

CO5: Exhibit professional ethics rooted in human values. 

CO6: Understand and advocate a holistic perception of harmony in nature 

and society. 

CA 20 

PR - MSE 20 

CR 2 ESE 60 

  TOTAL 100 

  

CO-PO Mapping:  

COs \ POs / 

PSOs 

PO

1 

PO

2 

PO

3 

PO

4 

PO

5 

PO

6 

PO

7 

PO

8 

PO

9 

PO

10 

PO

11 

PO

12 

PS

O1 

PS

O2 

PSO

3 

CO1 2 1 - - - 2 3 3 2 - - - - - - 

CO2 2 2 - - - 3 3 3 2 - - - - - - 

CO3 1 - - - - 3 3 3 2 - - - - - - 

CO4 - - - - - 2 3 2 2 - - - - - - 

CO5 - - 1 - - 3 3 2 2 2 - - - - - 

CO6 - - - - - - - 3 2 1 - - - - - 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Introduction to Value Education :Understanding Value Education, Self-

exploration as the Process for Value Education, Continuous Happiness and 

Prosperity – the Basic Human Aspirations, Right Understanding, Relationship 

and Physical Facility, Happiness and Prosperity – Current Scenario, Method to 

Fulfill the Basic Human Aspirations 

06 Hrs 

2 Harmony in the Human Being: Understanding Human being as the Co-

existence of the Self and the Body, Distinguishing between the Needs of the Self 

and the Body, The Body as an Instrument of the Self , Understanding Harmony in 

the Self , Harmony of the Self with the Body, Programme to Ensure self-

regulation and Health. 

06 Hrs 

3 Harmony in the Family and Society: Harmony in the Family – the Basic Unit 

of Human Interaction, Values in Human-to-Human Relationship, Trust' – the 

Foundational Value in Relationship, 'Respect' – as the Right Evaluation, 

Understanding Harmony in the Society, Vision for the Universal Human Order 

06 Hrs 

4 Harmony in the Nature (Existence): Understanding Harmony in the Nature, 

Interconnectedness self-regulation and Mutual Fulfillments among the Four 

Orders of Nature ,Realizing Existence as Co-existence at All Levels, The Holistic 

Perception of Harmony in Existence 

06  Hrs 

5 Implications of the Holistic Understanding – a Look at Professional Ethics: 

Natural Acceptance of Human Values, Definitiveness of (Ethical) Human 

Conduct, A Basis for Humanistic Education, Humanistic Constitution and 

Universal Human Order, Competence in Professional Ethics, Holistic 

Technologies, Production Systems and Management Models – Typical Case 

Studies, Strategies for Transition towards Value-based Life and Profession 

06  Hrs 

 Text Book and Teacher’s Manual: 

1. R. R. Gaur, R. Asthana, G. P. Bagaria, A Foundation Course in Human 

Values and Professional Ethics, 2nd Revised Edition, Excel Books, New 

Delhi, 2019. ISBN: 978-93-87034-47-1. 

2. R. R. Gaur, R. Asthana, G. P. Bagaria, Teachers’ Manual for A 

Foundation Course in Human Values and Professional Ethics, 2nd 

Revised Edition, Excel Books, New Delhi, 2019. ISBN: 978-93-87034-53-

2. 
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Reference Books: 

1. A. Nagaraj, Jeevan Vidya: Ek Parichaya. Amarkantak, India: Jeevan 

Vidya Prakashan, 1999. 

2.  A. N. Tripathi, Human Values. New Delhi, India: New Age International 

Publishers, 2004. 

3.  A. Leonard, The Story of Stuff: How Our Obsession with Stuff Is 

Trashing the Planet, Our Communities, and Our Health – and a Vision 

for Change. New York, NY, USA: Simon & Schuster (Free Press), 2011. 

4.  M. K. Gandhi, The Story of My Experiments with Truth. Ahmedabad, 

India: Navajivan Publishing House, 1927. 

5.  E. F. Schumacher, Small Is Beautiful: A Study of Economics as If People 

Mattered. London, UK: Blond & Briggs, 1973. 

6.  C. Andrews, Slow Is Beautiful: New Visions of Community, Leisure, and 

Joie de Vivre. Gabriola Island, BC, Canada: New Society Publishers, 2006. 

7.  J. C. Kumarappa, Economy of Permanence: A Quest for a Social Order 

Based on Non-violence. Varanasi, India: Sarva Seva Sangh Prakashan, 

1948. 

8. P. Sunderlal, Bharat Mein Angreji Raj. [Place/publisher/year to be 

confirmed]. 

9. Dharampal, Rediscovering India. New Delhi, India: Penguin Books India, 

1983. 

10.  M. K. Gandhi, Hind Swaraj or Indian Home Rule. Bombay, 

India: Navajivan Publishing House, 1909. 

11.  M. A. K. Azad, India Wins Freedom. New Delhi, India: Orient Longman, 

1959. 
12.  R. Rolland, Vivekananda , Kolkata, India: Vedanta Press, 1953  

13. R. Rolland, Gandhi ,New York, NY, USA: The Century Co., 1924  
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Syllabus of Minor (MDM) in IT Courses offered by 

Department of Information Technology at Second Year B.Tech Level 

 

Teaching 

Scheme 

Multidisciplinary Minor-1 

Data Structures 

Course code: 25AF1246MD306 

Examination 

Scheme 

TH 2 Prerequisite Courses:  

1. Programming and Problem Solving  

2. Fundamentals of  C Programming Languages 

Course Objectives: 

1. To teach efficient storage mechanisms of data for an easy 

access.  

2. To design and implementation of various basic and advanced 

data structures. 

3. To introduce various techniques for representation of the data in 

the real world.  

4. To develop application using data structures.  

5. To teach the concept of protection and management of data.  

 

Course Outcomes (COs): 

At the end of Course Students will be able To.  

CO1: Understand and apply efficient storage mechanisms for 

structured and unstructured data. 

CO2: Design and implement various basic and advanced data 

structures and hashing techniques. 

CO3: Analyze and select suitable data representation techniques for 

solving real-world computational problems. 

CO4: Implement applications using appropriate data structures to 

improve efficiency and scalability. 

CO5: Demonstrate knowledge of data protection, file organization, 

and effective data management strategies. 

CA 20 

PR - MSE 20 

CR 2 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 

PO
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O1 

PS

O2 

PSO

3 

CO1 3 2 2 2 2 1 1 1 1 1 1 2 3 3 2 

CO2 3 3 2 3 3 1 1 1 2 1 1 2 3 3 2 

CO3 3 3 3 3 2 1 1 1 2 2 1 2 3 2 2 

CO4 2 2 3 2 3 1 1 1 3 2 2 2 3 3 3 

CO5 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Linear Data Structures: Introduction to List, Array and Linked List, Stack: 

Stack Implementation using Array and Linked List, Applications of Stack, 

Queue: Queue Implementation, Applications of Queue. 

05 Hrs 

2 Non-Linear Data Structures: Trees: Trees and Terminologies, Tree Traversals 

(In-order, Pre-order, Post-order), Binary Search Tree (BST): In-order Traversal, 

Implementation of Search Algorithm, AVL Trees: Concept. 

05 Hrs 

3 Graphs and Advanced Data Structures: Graph Representation, Shortest Path 

Algorithms, Minimum Spanning Tree: Prim's &Kruskal's Algorithm. 

06 Hrs 

4 Sorting Algorithms & Techniques: Divide and Conquer Algorithms, Selection 

Sort, Bubble Sort, Insertion Sort, Merge Sort,Quick Sort and Applications.  
06 Hrs 

5 File Organization and B+ Trees: Directories and Contiguous Allocation, B+ 

Trees: Construction of B-tree, B+ Tree Insertion and Deletion, B+ Tree 

Maintenance and Efficiency. 

06 Hrs 

 Text Books: 
1. Weiss, M. A. (Year). Data Structures and Algorithm Analysis in C++ 

(Edition, if any). Pearson Education. 

2. Horowitz, E., Sahni, S., & Mehta, D. (Year). Fundamentals of Data 

Structures in C++ (Edition, if any). Universities Press. 

3. Cormen, T. H., Leiserson, C. E., Rivest, R. L., & Stein, C. (Year). 

Introduction to Algorithms (Edition, if any). MIT Press. 

Reference Books: 
1. Aho, A. V., Hopcroft, J. E., & Ullman, J. D. (Year). Data Structures and 

Algorithms (Edition, if any). Addison-Wesley. 

2. Thareja, R. (Year). Data Structures. Oxford University Press. 

 

 

Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No. NPTEL/SWAYAM 

Courses Name 

Instructor Host Institute Links 

01 Data Structures 

 

Dr.S.Sasikala University of Madras, 

Chennai, Tamil Nadu 

https://onlinecourses.swayam2.a

c.in/cec19_cs04/preview 
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Teaching 

Scheme 

Multidisciplinary Minor-2 

Computer Organization and Architecture 

Course code: 25AF1246MD405 

Examination 

Scheme 

TH 3 Prerequisite Courses:  

1. Digital Logic Design  
2. Fundamentals of Computer Programming  

Course Objectives: 

1. To understand the structure, function & characteristics of 

computer systems.  

2. To understand the design of the various functional units and 

components of digital computers 

3. To study hierarchical memory system including cache memories 

and virtual memory.  

4. To understand instruction level parallelism & parallel 

organization of multi-processor & multi core systems 

 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1. Explain processor structure & its functions. 

CO2. Solve problems based on computer arithmetic.  

CO3. Understand concepts related to memory & IO organization. 

CO4. Obtain knowledge about micro-programming of a processor. 

CO5. Acquire knowledge about instruction level parallelism & parallel 

organization of multiprocessors & multi core systems 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 

PO
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O1 

PS
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PSO

3 

CO1 3 2 - 1 2 - - - - - - 1 - - - 

CO2 3 3 - 2 2 - - - - - - 1 - - - 

CO3 3 2 - 1 2 - - - - - - 1 - - - 

CO4 3 2 2 2 2 - - 1 - - - 1 - - - 

CO5 3 3 2 2 3 - 1 - - - 1 2 - - - 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

Unit 

No. Topic Hours 

1 Introduction: Concept of computer organization and architecture, Fundamental 

unit, Computer function and interconnection, CPU structure and function. 

07 Hrs 

2 Instruction Sets: Characteristics, Types of operands, Types of operations, 

Assembly language, Addressing modes, Instruction format, Types of instruction, 

Instruction execution, Structure of program, Introduction to RISC and CISC 

architecture. Computer Arithmetic: The arithmetic and logic Unit, Integer 

representation, Integer arithmetic. 

08 Hrs 

3 Memory Organization: Internal Memory: Semiconductor main memory, Error 

detection & correction, Virtual memory systems and cache memory systems, 

External Memory: Organization and characteristics of magnetic disk, Optical 

memory, RAID. 

08Hrs 

4 Control Unit: Control unit operation: Micro-operations, Control of the processor, 

Hardwired implementation control unit, Micro-programmed Control Unit. 
07Hrs 

5 Input/ Output Organization: External devices, I/O module, Programmed I/O, 

Interrupt driven I/O, Direct memory access, Instruction pipe-lining: Concepts, 

Parallel processing: Multiple processor organization, Symmetric multiprocessor, 

Cache coherence and the MESI protocol. 

07 Hrs. 

 Text Books: 

1. William Stalling, “Computer Organization and Architecture: Designing 

for Performance”, Prentice Hall Publication, 8th edition, 2009.  

2. Hayes, “Computer Architecture and Organization”, McGraw-Hill 

Publication, 3rd edition, 2012.  

3. Zaky, “Computer Organization”, McGraw-Hill Publication, 5th edition, 

2011.  

   Reference Books: 

1. Morgan, Hennessy, Patterson, “Computer Architecture: A Quantitative 

Approach”, Kaufman Publication, 4th edition, 2007.  

2. Morris Mano, “Computer System Architecture”, Pearson Education 

India, 3rd edition, 2007.  

3. Mostafa Abd-El-Barr, Hesham El-Rewini, “Fundamentals of Computer 
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Organization and Architecture”, Wiley Publication, 1st edition, 2004.  

4. Miles J. Murdocca, Vincent P. Heuring, “Computer Architecture and 

Organization: An Integrated Approach”, Wiley Publication, 1st edition, 

2007.  

 

Alternative NPTEL/SWAYAM Digital Reference 

Sr.No. NPTEL/SWAYAM 

Courses Name 

Instructor Host Institute Links 

01 Computer 

Organization and 

Architecture 

Prof. Indrani 

Sen Gupta 

Prof. Kamalika 

Datta 

IIT Kharagpur https://nptel.ac.in/course 

s/106105163 
https://onlinecourses.nptel.ac.in/no

c25_cs154/preview 
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Syllabus of Honor Courses (HON) offered by Information Technology at 

Second Year B.Tech Level 
 

Teaching 

Scheme 

Honor (HON) Courses 

Optimization Techniques 
Course code: 25AF1246HON301 

Examination 

Scheme 

TH 3 Prerequisite Courses: 

1. Engineering Mathematics – I & II  

2. Discrete Mathematics  

3. Data Structures and Algorithms  

Course Objectives: 

1. Understand the fundamental concepts and need for optimization 

in engineering and IT domains. 

2. Learn mathematical modeling techniques and classical methods 

for linear and non-linear optimization problems. 

3. Apply optimization algorithms to real-world IT and computer 

science problems. 

4. Explore modern optimization tools including evolutionary and 

nature-inspired algorithms. 

Course Outcomes (COs): 

After completing the course, students will be able to: 

CO1: Formulate and classify optimization problems relevant to 

information technology. 

CO2: Solve linear programming problems using graphical and simplex 

methods. 

CO3: Apply unconstrained and constrained nonlinear optimization 

techniques. 

CO4: Implement dynamic programming and integer programming 

approaches in problem-solving. 

CO5:  Use modern heuristic and metaheuristic algorithms like Genetic 

Algorithms and Particle Swarm Optimization for solving complex 

IT-related problems. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
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3 
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3 
 

2 
 

3 
 

- 
 

1 
 

- 
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2 
 

1 
 

2 
 

3 
 

3 
 

2 
 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Mathematical preliminaries: Linear algebra and matrices , Vector space, 

eigen analysis, Elements of probability theory ,Elementary multivariable 

calculus 

07 Hrs 

2 Linear Programming: Introduction to linear programming model, Simplex 

method, Duality , Karmarkar's method 
07 Hrs 

3 Unconstrained optimization: One-dimensional search methods, Gradient- 

based methods , Conjugate direction and quasi-Newton methods 
 07 Hrs 

4 Constrained Optimization: Lagrange theorem , FONC, SONC, and SOSC 

conditions 
07 Hrs 

5 Non-linear problems: Non-linear constrained optimization models, KKT 

conditions ,Projection methods 
07 Hrs. 

 Text Books: 

1. Rao, S. S., “Engineering Optimization: Theory and Practice”, 4th 

Edition, Wiley India. 

2. Diwekar, Urmila, “Introduction to Applied Optimization”, 2nd Edition, 

Springer. 

3. Antoniou, Andreas, and Lu, Wu-Sheng, “Practical Optimization: 

Algorithms and Engineering Applications”, Springer. 

Reference Books: 

1. Rardin, Ronald L., “Optimization in Operations Research”, Pearson. 

2. Cavazzuti, Marco, “Optimization Methods: From Theory to Design”, 

Springer. 

3. Taha, H. A., “Operations Research: An Introduction”, 10th Edition, 

Pearson. 

4. Talbi, El-Ghazali, “Metaheuristics: From Design to Implementation”, 

Wiley. 

 

Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No. NPTEL/ SWAYAM 

Courses Name 

Instructor Host Institute Links 

1. Optimization from 

fundamentals 

Prof. Ankur A. 

Kulkarni 

IIT Bombay 

 

https://nptel.ac.in/courses/11

2101298 

 

 

Back to Index 

https://nptel.ac.in/courses/112101298
https://nptel.ac.in/courses/112101298
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Teaching 

Scheme 

Honor (HON) Courses 

Advanced Algorithms and Data Structures 
Course code: 25AF1246HON402 

Examination 

Scheme 

TH 3  Prerequisite Courses: 
1. Data Structures  

2. Analysis of Algorithms. 

3. Discrete Mathematics  

Course Objectives: 

1. To analyze and apply advanced data structures for solving real-

world computational problems. 

2. To explore optimization-focused algorithmic techniques including 

randomization and approximation. 

3. To understand computational geometry, string algorithms, and 

network flows in depth. 

4. To solve problems using advanced algorithm paradigms beyond 

traditional divide & conquer or dynamic programming. 

5. To implement complex algorithms using high-level languages and 

assess performance rigorously. 

Course Outcomes (COs): 

At the end of Course Students will be able. 
CO1: Understand and apply advanced data structures like Red-Black Trees, 

AVL Trees, and Hashing. 
CO2: Analyze and implement advanced graph algorithms including shortest 

paths and flows. 
CO3: Design algorithms using approximation, randomization, and online 

methods. 
CO4: Solve real-world problems using string algorithms and computational 

geometry techniques. 
CO5: Demonstrate proficiency in implementing complex algorithms and 

evaluating performance. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
PO
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PO
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PO

3 
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4 

PO
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O1 

PS
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CO1 3 2 3 2 2 - - - - - - - 3 3 2 

CO2 3 3 3 3 3 - - - - - - - 3 3 3 

CO3 3 3 3 3 3 2 - - - - - - 3 2 3 

CO4 3 3 3 3 2 - - - - - - - 2 2 3 

CO5 3 2 3 3 3 - - - - 2 - - 3 3 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Advanced Trees and Hashing: AVL Trees, Red-Black Trees, Splay Trees, B-Trees, 

Cuckoo Hashing, Extendible Hashing, Bloom Filters. 
07 Hrs 

2 Advanced Graph Algorithms: Bellman-Ford, Dijkstra’s, Floyd-Warshall, Network 

Flows (Ford-Fulkerson, Edmonds-Karp), Topological Sort. 
07 Hrs 

3 Approximation & Randomized Algorithms: Set Cover, Vertex Cover, Travelling 

Salesman Problem; Las Vegas vs. Monte Carlo, Hashing with Randomization. 
07 Hrs 

4 String Algorithms and Computational Geometry: KMP, Rabin-Karp, Suffix Trees; 

Convex Hull (Graham Scan), Line Segment Intersection, Closest Pair. 
07 Hrs 

5 Online Algorithms and Real-World Applications: Paging, k-Server Problem, Online 

Bipartite Matching; Applications in Networking, Bioinformatics, AI. 

07 Hrs. 

 Text Books: 

1. Cormen, T. H., et al., “Introduction to Algorithms”, MIT Press, 2022. 

2. Levitin, Anany, “Introduction to Design and Analysis of Algorithms”, 

Pearson, 2021. 

Reference Books: 

1. Horowitz, E., Sahni, S., and Rajasekaran, S., “Fundamentals of Computer 

Algorithms”, Galgotia, 2021. 

2. Mitzenmacher, Michael, and Upfal, Eli, “Probability and Computing”, 

Cambridge University Press. 

 

 

Alternative NPTEL/SWAYAM Digital Reference 
 

Sr.No. NPTEL/ SWAYAM 

Courses Name 

Instructor Host Institute Links 

1. Data Structure and 

Algorithms Using Java  

 Prof. Debasis 

Samanta  

IIT Kharagpur https://nptel.ac.in/courses/10

6105225 

2. Introduction to 

Algorithms and Analysis  

Prof. Sourav 

Mukhopadhyay  

IIT Kharagpur https://onlinecourses.nptel.a

c.in/noc25_cs150/preview 

 

 Back to Index 

https://nptel.ac.in/courses/106105225
https://nptel.ac.in/courses/106105225
https://onlinecourses.nptel.ac.in/noc25_cs150/preview
https://onlinecourses.nptel.ac.in/noc25_cs150/preview
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Syllabus of Double Minor Courses (DM) offered by Information 

Technology in at Second Year B.Tech Level 
 

Teaching 

Scheme 
Double Minor (DM) Courses  

Computer Networks Fundamentals  

Course code: 25AF1246DM301 

Examination 

Scheme 

TH 3 Prerequisite Courses: 
1. Basic Programming Concepts  

2. Basics of Data Communication 

Course Objectives: 

1. To introduce the fundamentals of computer networks and 

communication models. 

2. To explain key networking concepts such as protocols, architecture, 

and addressing. 

3. To provide insight into common networking devices and 

transmission media. 

4. To familiarize students with layered architecture (OSI and TCP/IP) 

and data flow. 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Describe basic concepts and terminology of computer networks. 

CO2: Explain the functions of various layers of the OSI and TCP/IP 

models. 

CO3: Identify networking devices, topologies, and transmission media. 

CO4: Understand addressing schemes like IP, MAC, and domain names. 

CO5: Summarize the role of protocols in enabling communication over 

networks. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 
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Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Introduction to Computer Networks: Definition and Uses of Computer 

Networks, Types of Networks: LAN, MAN, WAN, Network Topologies and 

Transmission Media, Network Devices: Router, Switch, Hub, Modem 

07 Hrs 

2 Network Models: OSI Reference Model: 7 Layers and Functions, TCP/IP Model 

and Comparison with OSI,Protocol Stack Overview 

07 Hrs 

3 Physical and Data Link Layer: Transmission Modes: Simplex, Half-Duplex, 

Full-Duplex, Error Detection Techniques (Parity, CRC), MAC Address and ARP 

Protocol 

07 Hrs 

4 Network and Transport Layer :IP Addressing (IPv4 & Introduction to IPv6) , 

Subnetting Basics, Routing Concepts and Protocols (Static, Dynamic) , TCP vs. 

UDP 

08 Hrs 

5 Application Layer and Services : DNS, HTTP, FTP, Email (SMTP/POP3), 

Network Security Basics (Firewall, VPN, Encryption Overview) , Internet and 

Web Basics. 

07 Hrs. 

 
Text Books: 

1. Behrouz A. Forouzan, Data Communications and Networking, McGraw-

Hill Education. 

Reference Books: 
1. James F. Kurose and Keith W. Ross, Computer Networking: A Top-Down 

Approach, Pearson Education. 

2. Andrew S. Tanenbaum, Computer Networks, Pearson Education. 

 

Alternative NPTEL/SWAYAM Digital Reference 

 

Sr.No. NPTEL/ SWAYAM 

Courses Name 

Instructor Host Institute Links 

1. Computer Networks 

 

 Dr. Karthik N    NIT, Puducherry https://onlinecourses.swayam

2.ac.in/ntr25_ed138/preview 

2. Computer Networks 

and Internet Protocol 

 

Prof. Soumya Kanti 

Ghosh, Prof. Sandip 

Chakraborty 

IIT Kharagpur 

 

https://nptel.ac.in/courses/10

6105183 

 

 

 

 

Back to Index 

https://onlinecourses.swayam2.ac.in/ntr25_ed138/preview
https://onlinecourses.swayam2.ac.in/ntr25_ed138/preview
https://nptel.ac.in/courses/106105183
https://nptel.ac.in/courses/106105183
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Teaching 

Scheme 
Double Minor (DM) Courses  

Data science and visualization  

Course code: 25AF1246DM402 

Examination 

Scheme 

TH 3 Prerequisite Courses: 
1. Programming Fundamentals  

2. Fundamentals of Data Structures and Algorithms 

Course Objectives: 

1. To introduce the basic concepts and techniques of data science. 

2. To enable students to perform data preprocessing, exploration, and 

visualization. 

3. To familiarize with tools and programming libraries used in data 

analysis and visualization. 

4. To equip students with practical skills in interpreting and visualizing 

real-world datasets. 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Understand the fundamental concepts of data science and analytics. 

CO2: Perform data preprocessing and cleaning using Python. 

CO3: Apply statistical techniques for data analysis. 

CO4: Use visualization tools (Matplotlib, Seaborn, Plotly) to interpret 

datasets. 

CO5: Build simple data-driven insights from real-world datasets. 

CA 20 

PR - MSE 20 

CR 3 ESE 60 

  TOTAL 100 

  

CO-PO Mapping: 

COs \ POs / 

PSOs 
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CO1 3 2 - - 2 - - - - - - 2 3 2 - 

CO2 3 3 2 2 3 - - - - - - 2 3 3 - 

CO3 3 3 2 3 2 - - - - - - 2 3 3 - 

CO4 2 3 3 2 3 - - - - 2 - 2 3 3 2 

CO5 3 3 3 3 3 - 2 2 2 3 2 3 3 3 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 Introduction to Data Science :Data Science process, lifecycle, and 

applications,Types of data: structured, semi-structured, and unstructured, Basics 

of statistics: mean, median, mode, standard deviation , Introduction to Python for 

Data Science. 

07 Hrs 

2 Data Collection and Preprocessing :Data collection methods: web scraping, 

APIs, datasets, Data cleaning: handling missing data, outliers, duplicate data, Data 

transformation: normalization, encoding categorical data ,Introduction to pandas 

and NumPy.                                                                                                                                                                     

07 Hrs 

3 Exploratory Data Analysis :Descriptive statistics and summary techniques, 

Correlation analysis and cross-tabulation, Grouping and aggregating data, Hands-

on using pandas for EDA. 

07 Hrs 

4 Data Visualization Techniques : Principles of effective visualization, Plotting 

using Matplotlib and Seaborn, Advanced charts: heatmaps, pair plots, histograms, 

box plots ,Introduction to interactive visualizations using Plotly. 

08 Hrs 

5 Case Studies and Applications : Real-world applications of data science in 

various domains. Interpreting datasets from government, health, finance, and 

social media. Data storytelling and presentation best practices. 

07 Hrs. 

 Textbooks: 
1. Grus, J., “Data Science from Scratch: First Principles with Python”, 

O'Reilly Media. 

2. VanderPlas, J., “Python Data Science Handbook”, O'Reilly. 

Reference Books: 
1. McKinney, W., “Python for Data Analysis”, O'Reilly. 

2. Wickham, H., “ggplot2: Elegant Graphics for Data Analysis”, Springer. 

3. Yau, N., “Data Points: Visualization That Means Something”, Wiley. 

 

Alternative NPTEL/SWAYAM Digital Reference 

 

Sr.No. NPTEL/ SWAYAM 

Courses Name 

Instructor Host Institute Links 

1. Data Science for 

Engineers 

 

Prof. Shankar 

Narasimhan, Prof. 

Ragunathan Rengasamy 

IIT Madras 

 

https://nptel.ac.in/courses/10

6106179 

2. Data Science 

Using Python 

 

Prof. Faisal Anwer, 

Prof. Mohammad 

Nadeem  

 Aligarh Muslim 

University 
https://onlinecourses.swaya

m2.ac.in/ini25_cs04/previe

w 

 

 
Back to Index 

https://nptel.ac.in/courses/106106179
https://nptel.ac.in/courses/106106179
https://onlinecourses.swayam2.ac.in/ini25_cs04/preview
https://onlinecourses.swayam2.ac.in/ini25_cs04/preview
https://onlinecourses.swayam2.ac.in/ini25_cs04/preview
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Syllabus of Exit options after Second Year, B.Tech to Qualify for 

Diploma 
 

Teaching 

Scheme 

Exit Course 

Mobile App Development 

Course code: 25AF1246EX401 

Examination 

Scheme 

TH  

120 

Course Objectives: 

1. To introduce learners to the fundamentals of Android operating 

system and mobile app development environments. 

2. To develop programming skills in Java and Kotlin for building 

Android applications. 

3. To enable learners to design effective user interfaces using 

Android UI components. 

4. To train learners in implementing data storage, database 

connectivity, and backend integration. 

5. To guide learners through the process of app deployment, 

publishing, and monetization. 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Describe the structure and functioning of Android applications. 

CO2: Write efficient Java/Kotlin code for Android-based solutions. 

CO3: Design and implement user-friendly interfaces using Android 

components. 

CO4: Integrate storage solutions like SQLite and Firebase into mobile 

applications. 

CO5: Build, test, and deploy Android apps to the Google Play Store. 

Original Course 

Certificates 

required at the 

time of 

evaluation 

PR 

CR 8 

  

  

CO-PO Mapping: 

COs \ POs 

/ PSOs 
PO

1 

PO
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11 

PO

12 

PS

O1 

PS
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3 

CO1 3 2 - - 2 - - - - - - 2 3 2 - 

CO2 3 3 2 - 3 - - 1 1 - - 2 3 3 1 

CO3 2 2 3 1 3 - 1 - 2 2 - 2 3 3 2 

CO4 3 3 2 2 3 - 1 - 1 - - 2 3 3 - 

CO5 2 2 3 2 3 1 1 1 3 3 2 3 3 3 3 

Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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 COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 

Introduction to Mobile App Development and Android Basics 
 Overview of Mobile App Development 

 Introduction to Android OS and Android Studio 

 Creating First Android Project 

 Understanding Project Structure and Folder Layout 

 Activities and Activity Lifecycle 

 Views and ViewGroups (Layouts) 

 LinearLayout, RelativeLayout, ConstraintLayout 

20 Hrs 

2 

Java Programming for Android 
 Java Basics: Data Types, Variables, Operators 

 Control Structures: if, switch, loops 

 Object-Oriented Concepts: 

o Class, Object, Inheritance, Polymorphism, Encapsulation 

 Exception Handling 

 Event Handling 

 Arrays and Strings 

 Introduction to Multithreading 

20 Hrs 

3 

Android User Interface Components 
 Buttons, TextView, EditText, CheckBox, RadioButton, ImageView 

 RecyclerView and ListView 

 Toast, Snackbar, Dialogs, Menus 

 Intents: Explicit and Implicit 

 Navigation between Activities 

 Fragments: Creation, Lifecycle, Fragment Transactions 

20 Hrs 

4 

Data Storage and Connectivity 
 SharedPreferences 

 Internal and External Storage 

 SQLite Database and CRUD Operations 

 WebView and JavaScript Integration 

 JSON Parsing 

 Firebase Integration (Realtime Database, Firestore) 

10 Hrs 

5 

Advanced App Features 
 Location and Maps (Google Maps API) 

 Services and Broadcast Receivers 

 Notifications 

 Introduction to Kotlin for Android 

 Integrating APIs (e.g., Weather API) 

 Working with Media: Audio, Video, Camera 

 Publishing an App: Generating Signed APK, Play Store Deployment 

 App Store Optimization (ASO) 

20 Hrs 
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6 

Capstone Projects and Industry Applications 
 Chat App using Firebase 

 Hotel Booking App 

 E-Commerce Shopping Cart App 

 YouTube Video Player App 

 Weather Forecast App using API 

 Calculator App 

 Tips for Interview Preparation 

 Freelancing and Monetization Opportunities  

 Mini Projects and Evaluation 

30 Hrs 

 
References: 

https://klic.mkcl.org/klic-courses/mobile-app-development 
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Teaching 

Scheme 

Exit Course 

Office Assistance 

Course code: 25AF1246EX402 

Examination 

Scheme 

TH  

120 Hr 

Course Objectives: 

1. Providing an excellent and consistent level of administrative 

support to the customers 

2. Scheduling executive meetings and travel plans 

3. Maintaining various types of data required in business matters 

4. Organizing various events and maintaining event expenses 

5. Creating presentations required in business 

Course Outcomes (COs): 

At the end of Course Students will be able. 

CO1: Providing an excellent and consistent level of administrative 

support to the customers 

CO2: Scheduling executive meetings and travel plans 

CO3: Maintaining various types of data required in business matters  

CO4: Organizing various events and maintaining event expenses 

CO5: Creating presentations required in business 

Original Course 

Certificates 

required at the 

time of 

evaluation 

PR 

CR 8 

  

  

CO-PO Mapping: 
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Note: Values in the matrix represent the level of correlation between COs and POs/ PSOs:1–Low, 2– 

Medium, 3–High. 
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COURSE CONTENT 

 

Unit 

No. Topic Hours 

1 

Word Processing : The Home Tab, The Insert Tab, The References Tab, The 

Mailings Tab, The Review Tab, The View Tab, Other Features, Using Automatic 

Features, Using the PDF Format, Using Forms and Creating Templates, Security, 

Word Processing in Other Languages, Case Studies 

20 Hrs 

2 

Spreadsheet : The Home Tab, The Insert Tab, The Page Layout Tab, The Data 

Tab, The Review and  View Tabs, Additional Excel Features, Security, Excel 

Extensions, Case Studies 

20 Hrs 

3 

Presentation Graphics : The Home Tab, The Insert Tab, The Design Tab, The 

Transitions Tab, The Animations Tab, The Slide Show Tab, Other Features, 

Spellings, Views and Masters, Additional File Tab Options, PowerPoint 

Extensions, Case Studies 

20 Hrs 

4 
Internet : Navigating the Web, Finding Information on the Web, Communication 

Using E-Mail, Internet Concepts, Unleashing the Power of Internet 
10 Hrs 

5 E-Mail : Configuring an E-mail Account, Composing and Sending Mail, 

Receiving, Replying To and Forwarding Mail, Organizing Mail. 
20 Hrs 

6 Case Studies and Live Project Work 30 Hrs 
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